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CombiFlash Torrent®

User Manual

Section 1 Introduction

1.1  Documentation Overview
This Installation Guide provides:

• Safety Information

• Unpacking instructions 

• Installation instructions, including placing the CombiFlash Torrent module on a 
network and direct connections with a computer or hand-held device

• Certification and warranty information.

Once you are operating the Torrent, you may refer to the Help menu for operating 
instructions and further assistance.

WARNING

Avoid hazardous practices! If you use this instrument in any way not specified in this 
manual, the protection provided by the instrument may be impaired; this may increase your 
risk of injury.

1.2  Product Overview
The Teledyne ISCO CombiFlash Torrent and Torrent AQ flash chromatography systems give 
you high-productivity automation, programmable gradients, UV or UV-Vis detection and 
peak separation, and automatic detection of columns. The Torrent can separate a sample in 
an unattended run under computer control at user selected flow rates between 50 and 
1000 mL/min. The Torrent operates up to 100 psi (6.9 bar) and can use low- or 
medium-pressure Flash columns for either normal or reversed phase separations. Braided 
stainless steel 2.75 meter (9 foot) supply lines are supplied with the Torrent. These supply 
lines support the solvent level detection features that prevent chromatography runs from 
running out of solvent. Samples can be introduced to the Torrent by injecting a liquid sample 
into the injection port. Liquid samples can also be pumped into the injection port using the 
optional Sample Load Pump. Alternately, liquid samples can automatically be loaded on the 
Torrent AQ using the integrated sample load line on the solvent select valve. The Torrent can 
load low-solubility and liquid samples using solid load sample cartridges.

Column eluate passes through the UV or UV-Vis detector which can trigger collection of peak 
fluids. The system also accepts an input signal to cut peaks using an external detector such 
as an ELSD instrument. The Torrent can control a Foxy R2 High Flow fraction collector or a 
Fractionation Valve to isolate the fluid in vessels.

Applications include development-scale purification of organic compounds for drug discovery 
and chemical research, as well as scale-up production for agrochemicals, petrochemicals, 
natural products, polymers, and catalysts.
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1.3  Operating Overview
The Torrent is equipped with a touch screen display for local control.

The system supports TCP/IP communication. This allows direct control of the Torrent by a 
Windows computer via a cross-over cable between Ethernet ports of the Torrent and the 
computer. The Windows computer must have Microsoft Internet Explorer 7 or newer.

TCP/IP communication also allows remote control via an established network. Remote 
controlling devices on the network can be a Windows PC or an Apple mobile digital device (iPod 
Touch, iPhone, and iPad).

 N ot Note

Teledyne ISCO recommends that you obtain assistance from your Information Technology 
department before attempting direct or network connections to a Windows computer.

1.3.1  Multiple Control Possibilities
The system can be accessed from the built-in touch panel and up to ten network computers. The 
touch panel shares control with all connected computers. The system performs the most recent 
command from any control input.

1.3.2  File Storage
To support operation from a variety of direct and network connections, the CombiFlash Torrent 
stores the software and all files on an internal hard drive. This ensures that your compound 
purification methods and run history files can be viewed from any connection. Optionally, 
individual run history files may be saved to a USB flash drive and the hard drive or a 
networked computer, and all run history files can be saved to a network drive.

1.4  Specifications

Table 1-1 CombiFlash Torrent Module Specifications1

Sample size: 0.5 to 300 grams

RediSep Rf column sizes: 80 gram to 3 kilogram

Flow rate: 50 – 1000 mL/min

Maximum pressure2: 6.89 bar (100 psi)

Detection: 200 – 360 nm (200 – 780 nm optional) with single, dual, or 
All-wavelength Collection.
Accepts external detector input.

Gradient: Binary, high pressure solvent mixing with linear, step, or isocratic 
capability. Two solvent inlets.

Gradient accuracy:  <2% full scale from 0.2 to 1.0 liter/min.

Sample injection: Automated injection with options of solid load cartridges, liquid load, or 
direct injection.

Controller: 26.7 cm (10.4 inch) touch screen
Supports remote control via Windows® PC. 

Software: On-screen method development and control with PeakTrak software

Fraction collection: Up to four fraction collectors, fractionation valve, or manual collection



Section 1  Introduction

1-3

EAR99 Technology Subject to Restrictions Contained on the Cover Page

1.5  Controls, Indicators, and Features
Figures 1-1 through 1-3 illustrate key features on the Torrent.

Solvent management: Patented, active level sensing for inlet and waste containers

Module dimensions:
(W x D x H)

47 x 43.5 x 71.4 cm
18.5 x 17.9 x 28.1 inches

Module weight: 65 lbs (29.5 kg)

Operating voltage: 100 VAC 50 Hz, 2 amperes
117 VAC 60 Hz, 2 amperes
234 VAC 50 Hz, 1 ampere
(±10% of the region’s nominal line voltage)

Safety and sample security: Static-dissipative tubing throughout, 
Vapor sensor for internal leak detection, 
Overpressure sensor, 
Active solvent and waste level sensing,
Audible alarm when user intervention is required.

Ambient Temperature 20 to 40°C (maximum temperature must be at least 15°C below the 
boiling point of the solvent)

Humidity (when connected to 
power)

95% relative humidity maximum at 20 to 40°C

Certification:  CE

Installation Category II

Maximum Altitude 2000 meters

Pollution Degree 2

Note 1. All specifications are subject to change.
Note 2. For columns undetected by RFID, the max pressure is limited to 50 psi.

Table 1-1 CombiFlash Torrent Module Specifications1

 (Continued)
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Figure 1-1  CombiFlash Torrent Features (Front)

1.Touch Panel LCD display – Large 10.4 inch display for system monitoring and control.

2.On/Standby Switch – 1 = On,  = standby.

3.Upper Column Mount Release – The upper column mount will latch at the top of its 
travel to ease column replacements. The latch holds the mount in place until the release is 
pushed to the left.

4.To Collector – On right side of instrument, not visible in the image. Eluate that is not 
diverted to waste is delivered to this outlet port for collection. Collection may be performed 
manually, or automated by a Foxy R2 High Flow fraction collector or a Fractionation Valve.

5.Upper Column Mount – The column mount holds the column in place and plumbs the 
mobile phase to the column inlet through interchangeable fittings that support a variety of 
column sizes.

6.Column – The Torrent is designed for use with RediSep® Flash chromatography columns 
which include RFID technology for automatic detection.

7.Lower Column Mount – The column mount holds the column in place and plumbs the 
column outlet to the internal UV or UV-vis detector.

8.Drip Tray and Drain – Should any leaks occur at the front panel fittings, the drip tray and 
drain will carry away the fluids. 

9.Sample Injection Port – This fitting accepts the sample though either a solid load sample 
cartridge (shown) or a liquid injection using a sample load pump, syringe, or similar device.

10.Injection Valve – The Torrent automatically positions this valve according to its current 
mode of operation. Modes include column equilibration, sample injection, elution, column 
flushing, valve cleaning, and air purging. 

11.Solid Load Cartridge – Solid load cartridges are a useful way to load low-solubility 
samples onto the column. Cartridges are available filled with silica gel, Celite, and C18 
media, or as empty cartridges to be filled with your media of choice. The cartridge outlet 
connects to the sample injection port (9).
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12.Solid Load Cartridge Cap – Adds the cartridge to the fluid path. An internal plunger 
minimizes any volume above the bed.

13.Solid Load Cartridge Cap Mount – This spring-loaded mount secures the solid load 
cartridge and cap in place.

14.USB Port – Convenient, front panel port that accepts USB Flash memory drive. A Flash 
memory drive may be inserted into this port for transferring files, importing and exporting 
methods, and Torrent software updates.

15.Solid Load Cartridge Tubing – This tubing connects to the Solid Load Cartridge Cap. 
In some configurations, such as a system purge, it can be connected to the Sample Injection 
Port. In configurations without solid load cartridges, the tubing is not used. 

Figure 1-2  CombiFlash Torrent Features (Side, close up)

16.Gas Inlet – The Torrent has an internal air pump that delivers air through the column for 
a post-run purge. The air is also used to detect solvent and waste levels. If you desire to use 
a specific gas such as nitrogen, connect the gas source to this port. 

17.Pressure Reference – When detecting solvent or waste levels in containers or conduits 
not exposed to atmospheric pressure, a headspace reference pressure is required so that 
the Torrent can read the differential pressure to determine levels. 

18.A Inlet – This port receives the A solvent.

19.A Level – This port measures the solvent A level by means of pressurized air or gas 
source.

20.B Prime – This port primes the B solvent pump (Torrent only). 

21.B Inlet – This port receives the B solvent.

22.B Level – This port measures the solvent B level by means of pressurized air or gas 
source.

23.Waste Valve – This port delivers waste fluids to a user-supplied waste container.
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24.Waste Level – The Torrent uses air or user-supplied gas to measure the hydrostatic 
pressure of the waste above the level sense line end. The system will suspend operation 
when this user-set level is too high.

25.Fraction Valve – The Torrent controls the optional Fractionation Valve through this port.

26.Sample Load Pump – The Torrent controls the optional Sample Load Pump through this 
port. 

27.Mains Power – Connects the Torrent to AC line voltage.

28.Power Outlet – Provides AC line voltage to an external device that meets the 115 VAC and 
2.0 ampere or 230 VAC and 1.0 ampere rating.

CAUTION

The back panel power connector is intended only for use with the Foxy R2 fraction collector. 
Do not connect other devices to this outlet. 

– Figure 1-3  CombiFlash Torrent Features (Back)

29.Cooling Fan – Cools the internal components.

30.Ethernet Port – An 8P8C jack for a network connection using a standard CAT5/6 cable, or 
for a direct connection to a computer using a cross-over cable.

31.USB Port – To interface with peripheral devices. This rear panel port is primarily for 
service-related functions.

1.6  Safety
Before installing, operating, or maintaining this equipment, it is imperative that all hazards 
and preventive measures are fully understood. While specific hazards may vary according to 
location and application, take heed in the following general warnings:
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WARNING

Avoid hazardous practices! If you use this instrument in any way not specified in this 
manual, the protection provided by the instrument may be impaired.

WARNING

Liquids associated with this instrument may be classified as carcinogenic, biohazard, 
flammable, or radioactive. Should these liquids be used, it is highly recommended that this 
application be accomplished in an isolated environment designed for these types of 
materials in accordance with federal, state, and local regulatory laws, and in compliance 
with your company’s chemical/hygiene plan in the event of a spill.

WARNING

If you are using flammable solvents or chemicals with this system, vapor concentration 
levels may exceed the maximum exposure levels as recommended by OSHA Guide 
1910.1000. To reduce those levels to a safe exposure, Teledyne ISCO recommends that you 
place the system in a laboratory hood designed for the purpose of ventilation. This hood 
should be constructed and operated in accordance with federal state and local regulations. 
In the event of a solvent or chemical spill, your organization should have a plan to deal with 
these mishaps. In all cases, use good laboratory practices and standard safety procedures. 

WARNING

The CombiFlash Torrent has redundant safety devices to limit pressure to less than 100 psi 
(689 kPa). RediSep columns smaller than 100 g are CE certified using standard IEC61010-1 
for use on the CombiFlash Torrent. RediSep columns larger than 100 g meet Pressure Vessel 
Directive 97/23/EC. Teledyne ISCO strongly recommends against the use of columns rated 
less than 100 psi (689 kPa).

1.6.1  Hazard Severity Levels
This manual applies Hazard Severity Levels to the safety alerts. These three levels are 
described in the sample alerts below.

CAUTION

Cautions identify a potential hazard, which if not avoided, may result in minor or moderate 
injury. This category can also warn you of unsafe practices, or conditions that may cause 
property damage.

WARNING

Warnings identify a potentially hazardous condition, which if not avoided, could result in 
death or serious injury.
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DANGER
Limited to the most extreme situations to identify an imminent hazard, which if not avoided, 
will result in death or serious injury.

1.6.2  Hazard Symbols
The equipment and this manual use symbols used to warn of hazards. The symbols are 
explained in Table 1-2.

Table 1-2 Hazard Symbols

Warnings and Cautions

The exclamation point within the triangle is a warning sign alerting you of 
important instructions in the instrument’s technical reference manual.

The lightning flash and arrowhead within the triangle is a warning sign alerting you 
of “dangerous voltage” inside the product.

The pinch point symbol warns you that your fingers or hands will be seriously 
injured if you place them between the moving parts of the mechanism near these 
symbols.

Symboles de sécurité

Ce symbole signale l’existence d’instructions importantes relatives au produit 
dans ce manuel.

Ce symbole signale la présence d’un danger d’électrocution.

Risque de pincement. Ces symboles vous avertit que les mains ou les doigts 
seront blessés sérieusement si vous les mettez entre les éléments en mouvement 
du mécanisme près de ces symboles

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnzeichen, das Sie darauf aufmerksam 
macht, daß wichtige Anleitungen zu diesem Handbuch gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, das Sei vor “gefährlichen 
Spannungen” im Inneren des Produkts warnt.

Vorsicht Quetschgefahr! Dieses Symbol warnt vor einer unmittelbar drohenden 
Verletzungsgefahr für Finger und Hände, wenn diese zwischen die beweglichen 
Teile des gekennzeichneten Gerätes geraten.
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1.7  For Additional Information
Technical assistance for the Torrent can be obtained from:

Teledyne ISCO
4700 Superior St.
Lincoln NE 68504

Phone: (800) 228-4373 or (402) 464-0231
Fax: (402) 465-3001
Email:  IscoService@teledyne.com

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las instrucciones del manual que 
acompañan a este producto.

Esta señal alerta sobre la presencia de alto voltaje en el interior del producto.

Punto del machacamiento. Sus dedos o manos seriusly serán dañados si usted 
los coloca entre las piezas móviles cerca de estos símbolos.

Table 1-2 Hazard Symbols (Continued)
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CombiFlash Torrent®

User Manual Guide

Section 2 Preparation

This section provides instructions for unpacking and installing the CombiFlash Torrent 
system. To prepare the system for operation, sequentially follow all instructions in sections 
2.1 through 2.19. Some of these sections provide instructions for installing optional 
equipment which should only be completed as required.

 N ot Note

Section 2.21 contains an Installation Qualification checklist. If required, sign off the checklist 
entries as you successfully complete the following sections.

2.1  Optional Equipment Modules
The Torrent/Torrent AQ offer several different optional modules. Each module will require 
additional set-up steps as noted below. The optional modules are: 

• Solvent Selection Valve (see Section 2.4.1; 2.6.2 and 2.8).

• Sample Load Pump (see Section 2.6.1 and 2.12.1).

• Fractionation Valve (see Section 2.4.2; 2.6.3 and 2.12.3).

• Foxy R2 High Flow Fraction Collector (see Section 2.6.4; 2.12.2 and/or 2.17).

2.2  Unpacking the Unit
The Torrent is shipped in a single carton. The optional equipment will be shipped in 
additional cartons. Carefully unpack the shipment and inspect the contents. 

WARNING

The Torrent is heavy. Use a two-person lift to prevent injury.

Lift the Torrent from the container using the lifting handles mounted on the side panels.

If there is damage to the shipping carton or any components, contact the shipping agent and 
Teledyne ISCO (or its authorized representative) immediately.

WARNING

If there is any evidence that the Torrent has been damaged in shipping, do not plug it into 
AC power. Contact Teledyne ISCO or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing slips. If there are any shortages, 
contact Teledyne ISCO immediately.
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2.3  Instrument Location
The Torrent has a relatively small footprint for a development-scale instrument, requiring 
about 2200 square centimeters (350 in2) of level bench space. Ensure that the Torrent has at 
least 3 cm (1.25") of air space behind it for ventilation. Additional space may be required for 
solvent and waste containers, and fraction collection.

Refer to Table 1-1 for environmental conditions and power requirements. 

WARNING

The system is heavy. Use a two-person lift to prevent injury.

Before making any connections to the Torrent, place it on the bench or in the fume hood where 
it will be operated. Temporarily position the Torrent so you can access the back panel to 
complete the connections.

2.4  Mounting Optional Modules
If a Solvent Select Valve or Fractionation valve are not being installed you can skip this section 
and continue to Section 2.5.

2.4.1  Solvent Select Valve (if purchased)
Place the Solvent Select Valve on the left-hand side of the Torrent with the valve facing the side 
of the Torrent. 

Use the supplied metal mounting plate and four (4) screws to secure the Solvent Select Valve to 
the Torrent.

Figure 2-1  Solvent Select Valve mounted on Torrent

2.4.2  Fractionation Valve (if purchased)
Place the Fractionation Valve on the right-hand side of the Torrent with the Valve facing the 
side of the Torrent. 
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Figure 2-2  Fractionation valve position before mounting.

Use the supplied metal mounting plate and four (4) screws to secure the Fractionation Valve 
to the Torrent. 

Alternatively, the valve can be connected to a user supplied mast. 

Figure 2-3  Fractionation valve after mounting

2.5  Connect Power
Ensure that the On/Standby switch above the touch screen panel is in the Standby position. 
Then, use the supplied IEC power cord to connect the Torrent to mains power. 

WARNING

Mains power must meet the voltage, frequency, and amperage requirements listed on the 
serial number label. Input voltage must be within ±10% of the region’s nominal line voltage. 
In the USA, this is 117 volts ±11.7 volts.

WARNING

As long as the AC mains power cord is connected to a live outlet, power is inside the unit. 
The mains power cord is the disconnect device. Position the Torrent so that the power cord 
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can be unplugged, or use a power strip where the plug can quickly be removed from the outlet 
in the event of an emergency.

CAUTION

Unless power must be removed due to an emergency, always wait at least one minute after 
placing the system in Standby before removing the AC mains power cord.

2.6  Connect Interface Cables
Rear panel connections support a variety of devices. Electrical connections to networks or 
optional equipment should be completed at this time.

Review the options below and complete as necessary. If any optional modules are not being 
installed you can continue to Section 2.7.

 N ot Note

Detailed information about each of these optional devices is provided in Section 2.12 Plumbing 
Optional Modules To Torrent. 

2.6.1  Cabling: Sample Load Pump
To connect a Sample Load Pump to the Torrent, attach the pump’s power cable to the Torrent’s 
back panel connector labeled “SAMPLE LOAD PUMP.”

Figure 2-4  Sample Load Pump power supply connection on back of Torrent.

2.6.2  Cabling: Solvent Select Valve 
To connect a Solvent Select Valve to the Torrent, attach the valves power cable to the back 
panel connector labeled “SAMPLE LOAD PUMP” and connect the USB cable to the USB port 
on the back panel. 
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Figure 2-5  Back of Torrent for electrical connections

2.6.3  Cabling: Fractionation Valve
To connect a Fractionation Valve to the Torrent, attach the valve’s 9-pin power/control cable 
between the port on the back of the Fractionation Valve to the Torrent’s back panel connector 
labeled “FRACTION VALVE.” 

Figure 2-6  Electrical Connection between Fractionation Valve and Torrent
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2.6.4  Cabling: Foxy R2 High Flow Fraction Collector
The Torrent can control up to four Foxy R2 High Flow fraction collectors via an Ethernet 
network. 

To connect one, or the first of multiple Foxys, connect a standard straight-through network 
cable between the Ethernet ports on the Torrent and a Foxy. The second Ethernet port on the 
Foxy can be used to add the next Foxy. See section 2.12.2 for more details. 

The Torrent can supply AC power to one Foxy. Connect one end of the cable to the female IEC 
connector on the Torrent. Connect the other end to the Foxy power connector.

Figure 2-7  Connection on back of Foxy R2 Fraction Collector to the Torrent

2.6.5  Cabling: Network Connection
The Torrent can be added to a network or directly connected to a computer for remote control. 

To add the Torrent to a network, connect a standard straight-through network cable between 
the Torrent’s Ethernet port and your network. 

To connect the Torrent directly to a computer, connect a “crossover” cable between the Ethernet 
ports on the Torrent and a stand-alone computer. 

To connect to a network, you will need access to IP addresses and network information from 
your IT department. For more information on network guidelines, see TN28 Networking 
Guidelines for CombiFlash Products, available at www.isco.com.

 N ot Note

When using the Foxy R2 High Flow fraction collector, the Torrent’s rear panel Ethernet connector 
will be in use. Instead, connect the cable to the available Ethernet port on the last Foxy in the chain.
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 N ot Note

The Foxy R2 fraction collector does not support DHCP. If you are adding the Torrent with Foxy R2 
fraction collectors to your organization’s network, a static IP address must be assigned to each 
unit. Contact your IT department for assistance.

 N ot Note

Detailed information about networking the Torrent with one or more Foxys is provided in 
Section 2.12.2.

2.7  Position the Torrent
After completing the various back panel connections, the Torrent can be moved to its 
operating position. Turn the Torrent so that the operator can access all of the front view 
features and controls. Use care not to damage the connections, cables and equipment while 
moving the Torrent.

CAUTION

Ensure that the CombiFlash Torrent has at least 3 cm (1.25") of air space behind it for 
ventilation.

Determine where the solvent and waste containers will be located. Keep in mind that the 
valve wash waste is located on the Torrent’s left side panel; diverter valve waste will come 
from the fraction collector or fractionation valve, usually positioned on the right side of the 
Torrent. If these will use a common waste container, determine the preferred location.

 N ot Note

A common waste container is recommended for waste level monitoring to prevent overfilling.

2.8  Connect Solvent Select Valve Plumbing
If a Solvent Select Valve is not being installed you can skip this section and continue to 
Section 2.9. If a Solvent Select Valve is to be installed with the Torrent or Torrent AQ it 
should already be mounted. 
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Figure 2-8  Solvent B Line connected to Solvent Selection Valve 

1.Connect the preswaged end of black tubing (023050308) to Torrent “B INLET”. 

2.Loosen (but don’t remove) the nut and 2-piece ferrule connected to the Solvent Select Valve 
port “TO TORRENT B INLET”. 

3.Place the free end of the black tubing into the port as far as it will go and finger tighten the 
nut. Then use a wrench to tighten for a n additional 1 and 1/4 turn. 

4.Locate a nut (60-0923-015) and ferrule (60-0083-163) in the accessory package 
(60-5249-002).

5. Insert the ferrule, narrow end first, into the Torrent “B LEVEL”. 

Figure 2-9  Solvent B Line on Torrent Connected to Solvent Selection Valve

6.Loosely thread the nut onto the “B LEVEL” port.
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7. Insert the clear air supply line (supplied with Solvent Select Valve) into the “B LEVEL” 
port until it is fully seated. 

8.Finger tighten the nut. If desired, tighten the nut an additional 1/2 turn using a wrench. 

9.Loosen the nut (but do not remove) to the Solvent Select Valve Port “TO TORRENT B 
LEVEL”. 

10.Following step 4 above, connect the air supply from the B LEVEL on the Torrent to the 
Solvent Select Valve “TO TORRENT B LEVEL”. 

2.9  Connect Solvent Lines

CAUTION

To prevent damage or premature wear to the pump and internal valves, clean solvent 
should be used. The solvent should not contain any dissolved solids. In addition, the B 
solvent pump on the Torrent and both Solvent A and Solvent B pumps on the Torrent AQ 
are not compatible with alkanes such as hexane due to lack of lubricity. If using water as a 
solvent, use Ultra Pure, DI or RO water. 

CAUTION

If solvent containers are reused, particulate matter can accumulate in the container. 
Containers should be thoroughly cleaned before each refill. Failure to clean the containers 
may result in damage to the solvent selection valve and internal components.

 N ot Note

The Torrent is shipped with protective caps on the solvent fittings. Remove these caps as you 
connect the solvent lines. The internal solvent lines contain isopropyl alcohol, some of which may 
drain when the caps are removed.

The Torrent may receive solvent from:

• User-supplied solvent containers at atmospheric pressure

• Pressurized or gravity-fed solvent delivery lines in the laboratory. 

Refer to the appropriate installation section (2.9.1 through 2.9.2) according to your solvent 
source.

2.9.1  Solvent Containers at Atmospheric Pressure
The Torrent can form a binary gradient from two solvents, A and B. These solvents connect to 
the left side panel of the Torrent or Torrent AQ with optional Solvent Select Valve allows for a 
binary gradient between one A solvent and either of two different B solvents or liquid sample. 

1.Locate the Solvent A inlet line. This assembly consists of  two tubes fastened together—a 
solvent line and a smaller diameter air line to measure the solvent level.

2.Connect the large fitting to the Torrent’s A INLET port:

3.Position the end with the threaded fitting near the port.
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4.Rotate the fitting until the inlet line is routed the desired direction.

5.Finger-tighten the pre-swaged fitting to the port. 

6.Use a wrench to tighten the fitting an additional 18 turn.

7.Connect the air line to the A LEVEL port (refer to Figure 2-10):

Figure 2-10  Level tubing connection with nut and ferrule

8.Locate a nut (60-0923-015) and ferrule (60-0083-163) in the accessory package 
(60-5249-002).

9. Insert the ferrule, narrow end first, into the A LEVEL port.

10.Loosely thread the nut onto the A LEVEL port. 

11.Insert the Solvent A air line into the A LEVEL port until it is fully seated.

12.Finger-tighten the nut. If desired, tighten the nut an additional 12 turn using a wrench.

Important
For systems without Solvent Select Valve follow steps 13-18. For systems with Solvent Select 
Valve skip to steps 19-27. 

13.Locate the Solvent B inlet line. This assembly consists of three tubes fastened together—a 
solvent line, a smaller diameter air line, and a solvent line.

14.Connect the large fitting on the Solvent B inlet line to the Torrent’s B INLET port as 
described in step 2.

15.Connect the smallest tube of the Solvent B inlet line to the B LEVEL port as described in 
step 7. 

16.Connect the remaining tube of the Solvent B inlet line to the B PRIME port:

17.Finger-tighten the pre-swaged fitting to the port labeled B PRIME. 

18.Use a wrench to tighten the fitting an additional 18 turn.

Figure 2-11  Solvent A line connected to the Torrent

Tubing

Nut
60-0923-015

Ferrule
60-0083-163

Level Port
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19.The Solvent Select Valve should be plumbed to the B Inlet of the Torrent.

Figure 2-12  Sample Inlet Line connected to Solvent Selection Valve 

20.Locate the Sample Inlet line. This assembly consists of two tubes fastened together--a 
white solvent line and a smaller diameter air line. 

21.Connect the large tubing on the sample line to the Solvent Select Valve’s SAMPLE INLET 
port with the pre-swaged nut and ferrule The connection should be finger-tight. Then, use 
a wrench to tighten the fitting an additional 1/8 turn. 

22.Connect the smaller tube of the sample inlet line to the Solvent Select Valve’s SAMPLE 
Level port as described in step 7. 

23.Locate the Solvent B1 inlet line. This assembly consists of two tubes fastened together--a 
solvent line and a smaller diameter air line.

24.Connect the large fitting on the Solvent B1 inlet line to the Solvent Select Valve’s B1 
INLET port as described in step 2 above. 

25.Connect the smalled tube of the Solvent B1 inlet line to the Solvent Select Valve’s B1 inlet 
line to the Solvent Select Valve’s B Level port as described in step 7. 

26.Locate the Solvent B2 inlet line and repeat Steps 24 and 25 for the B2 inlet line. 
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Figure 2-13  Solvent B1 and B2 supply lines connected to Solvent Selection Valve

The other ends of the Solvent A and B lines should be placed in the respective solvent 
containers. 

27.If installing onto a Torrent (not AQ), locate the 1/8-inch plug, part number 209-0165-21, in 
accessory kit 60-5249-002. Install this plug on the B Prime port.

2.9.2  Pressurized Solvent Lines in the Laboratory
When receiving solvent from pressurized lines on-site, the Torrent’s solvent level sensing 
feature is unsupported (and unnecessary).

 N ot Note

The solvent pressure should be regulated to not exceed 5 psi.

To complete the solvent connections:

1.Ensure that the solvent supply lines have shut-off valves. These valves must be accessible to 
the user. 

 N ot Note

The solvent supply should be shut-off when the system is not in use. Otherwise, pressurized 
solvent may be forced through the CombiFlash Torrent pump seals and leak from the waste port or 
other fluid path from the automated injection valve.

2.Locate the 18-inch plug, part number 209-0165-21, in accessory kit 60-5249-002. Install this 
plug on the B Prime port. 

3.Connect user-supplied tubing with 38-inch fittings from the source to the A Inlet and B Inlet 
ports on the side panel.
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 N ot Note

Solvent Level Sensing and B Solvent Prime options should be disabled when completing the 
system configuration settings.

2.10  Connect Waste Lines

WARNING

Risk of fire or equipment damage. Failure to connect Waste Port tubing may allow organic 
solvents to pool in unsafe areas, possibly creating dangerous levels of flammable vapors.

CAUTION

Elevated flammable vapor levels are possible. Ensure that the waste container is 
adequately ventilated, preferably by placing it in a fume hood.

 N ot Note

The Torrent is shipped with protective caps on the waste fittings. Remove these caps as you 
connect the waste lines. The internal solvent lines contain isopropyl alcohol, some of which may 
drain when the caps are removed.

 N ot Note

Waste connections on the left side panel are labeled with a Waste icon.

The waste tube assembly is a bundle of two tubes that routes post-run valve wash fluid to a 
waste container. Instructions for diverter valve waste tubing is covered in section 2.12.

Figure 2-14  Waste Line connected to the Torrent
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To connect the waste tube assembly to the Torrent:

1.Select the tube with the pre-swaged nut and ferrule and connect this end to the port labeled 
VALVE. The connection should be finger-tight. Then, use a wrench to tighten the fitting an 
additional 18 turn.

2.Connect the other line to the LEVEL port.

3.Locate a nut (60-0923-015) and ferrule (60-0083-163) in the accessory package 
(60-5249-002).

4. Insert the ferrule, narrow end first, into the LEVEL port.

5.Loosely thread the nut onto the LEVEL port.

6. Insert the waste air line into the LEVEL port until it is fully seated.

7.Finger-tighten the nut. If desired, tighten the nut an additional 12 turn using a wrench.

The other ends of the Waste line should be placed in the waste container. 

If using the optional Waste Outlet Cap (60-5394-512 for 83B closures, 60-5394-513 for 100 mm 
closures), proceed with the following steps:

8.Place the metal plate inside the plastic cap (Figure 2-15). The plate should be oriented so 
that the small tube will extend into the carboy. The small tube should extend 5 ±0.5 cm long 
from nut. If the tube is missing, insert it now and finger-tighten the nut.

Figure 2-15  Optional Waste Cap (83B cap shown)

9.The tubing is secured using metal, spring-type retainers. A pair of conventional pliers will 
allow you to open the retainer enough to slide it onto the tubing. On the larger diameter 
waste tube, slide one retainer about 2 inches (5 cm) onto the tubing end.

10.Feed this tube into the top of the metal plate until the retainer is against the top of the 
plate.

11.Slide a retainer onto the tubing end until it is seated against the bottom of the metal plate.

12.Thread the cap onto the carboy.

13.The smaller diameter tube is the level sense tube. Push this tube about 2 cm into the top 
fitting and finger-tighten the nut.

If an optional waste cap is not used, ensure the waste lines are secured so they drain into the 
waste container. Secure the Waste Level Sense air tubing so its outlet is at least two inches (5 
cm) below the container’s maximum level. Seal the container opening to avoid solvent vapors.

Nut

Metal Plate

5 cm tube extending
into carboy

Spring-type
Retainer

Place a retainer above and 
below the metal plate.
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2.11  Connect and Route Drain Line

WARNING

Risk of fire or equipment damage. Failure to connect drain lines may allow organic solvents 
to pool in unsafe areas, creating a potential for dangerous levels of flammable vapors. 
Improper draining may damage the instrument’s internal components.

The Torrent has a front-mounted drip tray. There is a drain connection under the left side of 
the tray. Connect user-supplied tubing to this drain and route it to a suitable waste fluid 
collection container.

2.12  Plumbing Optional Modules to Torrent
The installation of optional equipment that was electrically connected to the Torrent in 
section 2.6 should be completed now. Review the options below and complete as necessary. If 
any optional modules are not being installed you can skip this section and continue to section 
2.13.

2.12.1  Optional Sample Load Pump
1.Position the Sample Load Pump on top or near the Torrent.

2.Connect the tubing between the pump outlet (from the bottom of the pump head) and the 
Torrent’s sample injection port (Figure 1-1, item 9).

3.Configure the Sample Load Pump by placing either the plastic cartridge reservoir or the 
tubing with the weighted end on the pump inlet (Figure 2-17).

Figure 2-16  Sample Load Pump connected to the Torrent Sample Injection Port. 
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Figure 2-17  Sample load pump

Figure 2-18  Plumbing Sample Inlet to Sample Loading Pump

2.12.2  Optional Foxy R2 High Flow Fraction Collector
The fraction collector(s) should be positioned to the right of the Torrent. Complete information 
about the Foxy R2 fraction collector is provided in its user manual, part #69-2133-667.

Plumbing Setup:

1.Connect the 107 cm (42 inch) piece of supplied tubing between the Torrent’s TO 
COLLECTOR port and the fraction collector’s diverter valve IN port (Common). Use caution 
when tightening the hardware to prevent damage to the diverter valve.

Pump Outlet

To Sample Injection Port

Cartridge Reservoir

Tubing with 
Weighted End

Pump Inlet
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Figure 2-19  Foxy R2 plumbing connection to the Torrent

2. If there are multiple fraction collectors, connect the 107 cm (42 inch) piece of supplied 
tubing between the first fraction collector’s diverter valve WASTE port (NO) and the next 
collector’s diverter valve IN port (Common). Repeat this for each fraction collector in the 
chain.

Figure 2-20  Plumbing at the Foxy R2 Diverter valve 

3.On the last fraction collector (or single), connect the 6 ft. piece of supplied tubing between 
the diverter valve WASTE port (NO) and a suitable waste collection container. Cut the 
tubing to the desired length. 

4.For waste level monitoring, the valve wash waste container (section 2.10) is recommended 
for collecting diverter valve waste. 
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5. Install racks or funnels as described in the Installation Guide.

Figure 2-21  Foxy R2 high flow diverter valve ports (front view)

6.Use the supplied cable ties to secure the tubing as desired. Before turning on any fraction 
collector, manually move each fraction collector’s arm and drop former through its full range 
of movement to ensure that the arm mechanisms move freely without obstruction. The Foxy 
R2 will need to be configured once the system is powered on (Section 2.15 or 2.16).

2.12.3  Optional Fractionation Valve
The fractionation valve is an alternative to the typical Foxy fraction collector setup, allowing 
the effluent from the Torrent to be collected in any of six user-supplied containers. The 
fractionation valve module includes a diverter valve to allow the effluent to be diverted to 
waste.

1.Connect the supplied tubing between the Torrent’s TO COLLECTOR port and the 
Fractionation Valve’s diverter valve IN port (Common). (The diverter valve is an externally 
mounted solenoid valve on the side of the Fractionation Valve.)

2.Connect the supplied tubing between the Fractionation Valve Common Port to the 
Fractionation Valve’s diverter valve top port. 

Figure 2-22  Fractionation Valve Plumbing to Torrent

Waste (NO)

In (Common)

Drop Former (NC)
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Figure 2-23  Fractionation Valve Diverter Valve to Fractionation Valve 6-Port Valve

Figure 2-24  Fractionation valve: Diverter to waste valve connections

3.Cut lengths of tubing and connect the pieces to the six numbered outlet ports on the front 
valve (Figure 2-6).

4.For your convenience, the Fractionation Valve was shipped with pairs of numbered clips to 
simplify tube and container identification. If desired, attach the clips to the each end of the 
six outlet tubes.

5.Secure the six outlet tubing ends in the waste containers. 
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 N ot Note

Tubing may be secured in the collection containers using optional bottle caps with spring-type 
retainers. For GL38 threads, use 60-5394-516; for GL45 threads, use 60-5394-517.

Figure 2-25  Fractional Valve

Figure 2-26  Fractional Valve
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2.13  Model 340CF Evaporative Light Scattering Detector (ELSD)
The Torrent can be configured for use with Teledyne ISCO’s 340CF ELSD. 

If a 340CF ELSD is no being installed you can skip this section and continue to 

Section 2.14. The data connection between the Torrent and the ELSD requires either a Foxy 
R2 fraction collector (Section 2.12.2) or the fractionation valve (Section 2.6.3).

Connect the ELSD to the DETECTOR port on the rear panel of the Foxy R2 or the 
fractionation valve with signal cable (250000020) from the 340CF Accessory Package 
(4-200203).

 N ot Note

If your system has more than one fraction collector, connect the ELSD to the first unit plumbed to 
the Torrent. 

Figure 2-27  Detector port on fractionation valve (left) and Foxy R2 fraction collector (right)

Plumbing the Torrent to the ELSD requires the connection package, part #60-5247-021. The 
package contains the following: 

• Metal Tee fitting with reducer

• Two 0.25” mounting spacers for tee

• Two #6x1” pan head screws/flat washers/lock washers

• 1 pc 1/16 OD x 0.02” ID x 6” long tubing

• 1 pc 0.25 OD x 0.188” ID x 100cm long black PTFE tubing w/nut and ferrule swaged on 
each end

• 1 pc 0.25 OD x 0.188” ID x 100cm long black PTFE tubing w/nut and ferrule swaged one 
end and a metal union on the other end
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To plumb the ELSD to the Torrent: 

1.With a 3/32” Allen wrench, remove the PEEK tee fitting and metal tubing from the rear 
panel of the ELSD unit (refer to Figure 2-9). This will expose both mounting holes for the 
metal tee fitting. 

Figure 2-28  ELSD rear panel

2.Using the two long screws with lock and flat washers, mount the metal tee fitting on the rear 
panel, aligning the two standoffs over the ELSD’s threaded mounting holes, and the 
mounting holes in the tee over the two standoffs. 

Figure 2-29  Replace the PEEK tee with the metal tee fitting
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3.Locate the 6” piece of tubing. Attach one end to the bottom of the metal tee fitting and the 
other end to the ELSD liquid inlet (refer to Figure 2-11). Tighten fittings to finger, tight. 

4.On the Torrent, disconnect the black PTFE tubing end from the bottom column connection 
(Figure 2-10). 

Figure 2-10 Torrent: Disconnect tubing from bottom column connection 

5.Locate the black PTFE tubing that is swaged on both ends. Connect one end to the Torrent 
bottom column connection. Connect the other end to the metal tee fitting on the back of the 
ELSD. 

6. Locate the other piece of black PTFE tubing from the kit. Connect the metal union to the 
swaged tubing on the front of the Torrent. Connect the swaged end of the tubing to the metal 
tee fitting on the back of the ELSD. 

Figure 2-30  Tee fitting for Torrent ELSD

2.14  Grounding

WARNING

Risk of fire or explosion. Nonconductive, nonpolar liquids at linear velocities greater than 
40 cm/sec will develop an electrostatic charge. If this applies to your application, all 
components along the fluid path must be electrically grounded. An electrical ground is 
necessary to dissipate electrostatic charges that may build while collecting fluids such as 
organic solvents. 

Refer to your local health and safety directives and ground the solvent delivery lines, Torrent, 
optional equipment, and collection and waste containers according to these governing 
directives.

 N ot Note

The entire fluid path of the Torrent is electrically grounded. The black tubing is conductive. 
Never substitute the black tubing. 
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2.15  Turn on Power
The Torrent’s power switch is located above the touch screen panel. Turn the switch to the ON 
positions. Peripheral equipment should also be turned on at this time. The Torrent will begin 
its startup routine which includes self diagnostics. The Torrent is ready for operation when the 
PeakTrak screen is displayed. 

2.16  Torrent/Multiple Foxy R2 Network Configurations
Before connecting the Torrent and fraction collector(s) to the network, verify that the Torrent is 
properly booted up with no errors. 

Examples of system connections are provided at the end of this section. 

 N ot Note

The Foxy R2 fraction collector does not support DHCP. If you are adding the Torrent with Foxy R2 
fraction collectors to your organization’s network, a static IP address must be assigned to each unit. 
Contact your IT department for assistance. 

 N ot Note

This section is dedicated to network configurations including the Foxy R2 fraction collector. 

TCP/IP Settings in the Foxy R2

The IP address and netmask are entered from the fraction collector front panel.

1.Select Configuration Tools.

2.Enter the IP address and netmask obtained from your network administrator.
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Figure 2-31  TCP/IP Settings for Foxy R2 Fraction Collector

3.Press Enter to save settings and exit.

2.16.1  TCP/IP Settings in the Torrent
The network information for the Torrent is entered from the front panel.

1.Select Tools -> Configuration, and click the Network Configuration tab.

2.Enter the IP address, netmask, and gateway address assigned to the Torrent by your 
network administrator.

Figure 2-32  TCP/IP settings for Torrent

 N ot Note

The bottom two panels on the Network Configuration tab are not used for connection to 
networked instruments.

3.Select the Fraction Collector tab.

4.Enter the IP address(es) of the Foxy R2 fraction collector(s).

   IP   

  1.202 
192.168.

IP MASK 

255.  0 
255.255.

  MAC   

00:00:00
00:17:8b

IP 
MASK

255.  0 
255.255.

   IP   

  1.202 
192.168.
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Figure 2-33  Enter Fraction Collector IP information into Torrent (up to four units)

Torrent/Foxy R2 Network Configuration: Examples

Typical examples of Torrent/Foxy R2 network connection are provided in this section. When 
configuring your network, observe the following important guidelines:

• All network connections are made with straight-through network cables. If purchased 
from Teledyne ISCO, straight-through cables are tan in color.

• Do not use crossover cables in networked systems. This type of cable is only for direct 
connection to a stand-alone computer. If purchased from Teledyne isco, crossover cables 
are blue in color.

• A unique static IP address must be assigned to each unit.

In Example 1, the system runs on your network, using the fraction collector as an Ethernet 
hub.

Figure 2-34  Network configurations: Example 1

In Example 2, the system runs on your network with each unit directly connected to your 
network.

Your network

Foxy R2
rear panel

Torrent rear panel

Foxy R2
rear panel
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Figure 2-35  Network configurations: Example 2

In Example 3, the system runs on your network with each unit connected to an Ethernet hub, 
and then to your network. 

The pass-through function of a true Ethernet hub is required for this setup, meaning all ports 
are sent the same signals.

Some switches can be set to mimic a hub. If you use a switch, ensure that it is set to mimic 
the functionality of a hub, and does not apply logic filtering.

Figure 2-36  Network configurations: Example 3
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2.17  Purge the Internal Solvent Lines (System without Solvent Selection Valve)
If setting up the with a Solvent Selection Valve skip to section 18. The Torrent is shipped from 
the factory with isopropyl alcohol in the internal lines. Before the first use, the lines should be 
purged. To do so:

1.Connect the solid load cartridge tubing to the sample injection port.

CAUTION

Pinch point. Your fingers or hands can be seriously injured if you place them 
between the moving parts of the Solid Load Cartridge Cap Mount or the Upper 
Column Mount. Use care when installing solid load cartridges or columns.

2. Insert the column bypass tube (part number 209-0165-76 from accessory kit 60-5249-002).

3.Ensure that the Solvent A inlet line is receiving hexane, and the Solvent B inlet is receiving 
ethyl acetate.

4.Select the “Tools>Manual Control” menu command to open the Manual Control window.

5.Select the THROUGH COLUMN & CARTRIDGE Valve Position setting.

6.Touch the PRIME B button. The solvent pump will start. 

 N ot Note

When pumping solvents the first time, inspect the solvent and waste connections to the system. If 
any leaks are observed, click the STOP button. Correct the leak by tightening the fitting an additional 
14 turn, and then restart the pump by touching the PRIME B button.

7.After at least 400 mL of solvent has been pumped, touch the STOP button.

8.Touch the PRIME A button. The solvent pump will start. Inspect the solvent and waste lines 
and correct leaks if necessary.

9.After at least 400 mL of solvent has been pumped, touch the STOP button.

10.Close the Manual Control window.

11.After the pressure gauge on the touch screen has returned to 0 psi, remove the column 
bypass tube and disconnect the solid load cartridge tubing from the Sample Injection Port. 
The column bypass tube should be drained and returned to the accessory kit.

 N ot Note

If using the optional Sample Load Pump, purge the pump with at least 20 mL of Solvent A and run 
the pump dry.

After purging the lines, the system is ready for the optional system verification (Section 2.20) 
or operation.
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2.18  Purge the Internal Solvent Lines (Solvent Selection Valve)
The Torrent is shipped from the factory with isopropyl alcohol in the internal lines. Before the 
first use, the lines should be purged. To do so:

1.Connect the solid load cartridge tubing to the sample injection port Figure: 2-10.

CAUTION

Pinch point. Your fingers or hands can be seriously injured if you place them between the 
moving parts of the Solid Load Cartridge Cap Mount or the Upper Column Mount. Use care 
when installing solid load cartridges or columns.

2. Insert the column bypass tube (part number 209-0165-76 from accessory kit 60-5249-002).

3.Ensure that the Solvent A inlet line is receiving water, and the Solvent B inlet is receiving 
methanol or another suitable organic modifier. If using the optional Solvent Selection 
Valve, choose methanol (or another suitable organic solvent) as the B1 solvent and an 
additional organic solvent as the B2 solvent.

4.Select the “Tools>Manual Control” menu command to open the Manual Control window.

5.Select the THROUGH COLUMN & CARTRIDGE Valve Position setting.

6.Touch the PRIME B1 button. The solvent pump will start. 

 N ot Note

When pumping solvents the first time, inspect the solvent and waste connections to the system. If 
any leaks are observed, click the STOP button. Correct the leak by tightening the fitting an 
additional 14 turn, and then restart the pump by touching the PRIME B button.

7.After at least 400 mL of solvent has been pumped, touch the STOP button.

8.Repeat steps 6 and 7 for the B2 solvent. Touch the PRIME A button. The solvent pump will 
start. Inspect the solvent and waste lines and correct leaks if necessary.

9.After at least 400 mL of solvent has been pumped, touch the STOP button.

10.Close the Manual Control window.

11.After the pressure gauge on the touch screen has returned to 0 psi, remove the column 
bypass tube and disconnect the solid load cartridge tubing from the Sample Injection Port. 
The column bypass tube should be drained and returned to the accessory kit.

 N ot Note

If using the optional Sample Load Pump, purge the pump with at least 20 mL of Solvent A and run the 
pump dry.After purging the lines, the system is ready for the optional system verification (Section 2.20) or 
operation.

2.19  System Verification 
It is recommended that the system operation be verified. To do so, follow the directions 
supplied with the Torrent Verification Kit. Be sure to follow the correct instructions 
depending if the system is set up for normal or reverse phase solvent operation.
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2.20  Accessory Kit
The Torrent is shipped with an accessory kit (60-5249-002).

Some of the kit components are used during installation. Other components should be available 
for use with the system whenever there is a need to change the configuration. Because some of 
these components are needed to match the column and solid load cartridge cap sizes, Teledyne 
ISCO recommends that you keep the kit near the Torrent.

Key components in this accessory kit are identified in sections 2.20.1 through 2.20.8.

2.20.1  Inlet and Outlet Fittings for Columns and Cartridges
The luer adapters match the inlet and outlet fittings to the size of the column inlet and outlet. 
The Torrent was shipped with fittings matched for 330 gram column sizes and smaller. When 
using 750 gram columns or larger, the fittings must be changed.

To change column luer adapters (top and bottom):

1.Unthread the knurled cap and remove the luer adapter (Figure 2-37).

2.Align the new adapter with the key in the recess. Ensure that the adapter is full seated in 
the recess.

3.Replace the knurled cap

4.Repeat steps 1 through 3 for the other adapter.

Figure 2-37  Changing column luer adapters

The cartridge outlet (sample injection port) also has a fitting that can be changed to match the 
cartridge size. The Torrent was shipped with a luer adapter matched for 260 gram cartridges 
and smaller. When using 375 gram cartridges or larger, the cartridge outlet fitting must be 
changed. The steps are the same as the column fittings. Refer to the Cartridge Outlet details on 

Knurled Cap

Luer Adapter (Male): 
60-5243-075 330 g columns (shown)
60-5243-074 750 g to 3 kg columns 

Keyed recess

Knurled Cap

Luer Adapter (Female): 
60-5244-116 330 g columns (shown)
60-5244-126 750 g to 1.5 kg columns 
60-5244-118 3 kg columns 
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Figure 2-38.

 N ot Note

Adapters that are not in use should be stored in the accessory kit for future use.

Figure 2-38  Changing cartridge inlet and outlet adapters 

2.20.2  Cartridge Inlet Adapter
An adapter is required when using 25 and 65 gram solid load cartridge caps. Locate the 25/65 
g Cartridge Adapter (60-5244-058) and thread it into the cartridge cap so that it can accept 
the inlet tubing.

2.20.3  Direct Injection Adapter
The Direct Injection Adapter (60-5244-101) secures the luer fitting to allow faster tubing 
changes. When a column is held in place by the downward force of the column mount, 
removing the tubing from the upper column mount will cause the luer adapter to be ejected. 
Placing the Direct Injection Adapter between the upper column mount and the tubing will 
hold the luer adapter in place and provide a threaded fitting for easy tubing changes.

The Direct Injection Adapter is recommended when using the Liquid Load Pump to load 
samples directly on the column, or when there is a need to bypass the automated injection 
valve during sample injections.

Cartridge Inlet
Solid Load Cartridge Adapter: 
60-5244-058 for 25 and 65 g solid load 
cartridge caps. 
Not required for larger sizes

Cartridge Outlet (under cap)
Luer Adapter (Female): 
60-5244-116 260 g cartridges
60-5244-126 375 g cartridges

25 gram cartridge 
and cap shown

Sample 
Injection Port

Knurled Cap
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2.20.4  Liquid Injection Adapter 
The Liquid Injection Adapter (60-5244-059) should be used when performing liquid sample 
injections with a syringe. The valve prevents the liquid from be forced back out of the injection 
port. 

2.20.5  Prime Tube Assembly
The prime tube assembly (209-0165-76), also called a column bypass tube, can be used in place 
of a column when purging/priming the system and when performing maintenance.

2.20.6  Prime Pump Plug, 1/8-inch
Use this plug (209-0165-21) to cap the B Solvent’s Prime port when this port is not in use.

2.20.7  Stylus
The stylus with adhesive-backed mounting plate may be attached near the LCD display for 
precise control of the touch screen.

2.20.8  Cable Clips and Ties
Use the clips and ties to secure tubing or wiring after installation.
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2.21  Installation Qualification Checklist
Table 2-1 can be completed to verify and document the installation procedures contained in 
Section 2 of this guide.

Table 2-1 Installation Qualification Checklist

Step Description
Installer 
Initials

Operator 
Initials

2.1 UNPACKING THE UNIT

2.3 INSTRUMENT LOCATION

2.5 CONNECT POWER

2.6 CONNECT INTERFACE CABLES

2.7 POSITION THE TORRENT

2.8 CONNECT SOLVENT SELECT VALVE PLUMBING

2.10 CONNECT WASTE LINES

OPTIONAL EXTERNAL GAS

2.11 CONNECT AND ROUTE DRAIN LINE

2.12 PLUMBING OPTIONAL MODULES TO TORRENT

2.14 GROUNDING

2.15 TURN ON POWER

2.16 CONFIGURE THE TORRENT

2.17 PURGE THE INTERNAL SOLVENT LINES (SYSTEM 
WITHOUT SOLVENT SELECTION VALVE)

2.18 SYSTEM VERIFICATION WITH UNIVERSAL TEST 
MIX

Certification of Section 2 Completion
Installer Name (print):

Installer Signature:
Date:

Operator Name (print):

Operator Signature:
Date:

Comments:
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CombiFlash Torrent®

User Manual

Section 3 Configuration

3.1  Configure the Torrent

Figure 3-1  Configuration Screen

Before operating the Torrent, it must be configured for the desired operation. To configure the 
module, open the Configuration window by selecting Tools>Configuration from the PeakTrak 
menu.

The configuration window has four tabs: Instrument Configuration, Network Configuration, 
User Preferences, and Fraction Collector. Network Configuration settings are discussed later 
in Section 5, Remote Interfaces.

Adjust the following on the Instrument Configuration, User Preferences, and if applicable, 
the Fraction Collector tabs 2-29 (sections 2.13.1 through 2.13.3) for the desired operation and 
then click OK to save the settings.

Some configuration settings do not take effect until the system is restarted. After completing 
sections 2.13.1 through 2.13.3 follow the instructions in section 2.13.4.

3.1.1  Instrument Configuration
Solvents - When you installed the system, two solvents were connected to the back panel. 
This section of the Instrument Configuration tab allows you to name these solvents. To do so:

1.Click the “Add Solvent” button.

2.Enter the solvent name and click the OK button.

3.Repeat steps 1 and 2 for all solvents.
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Solvent Level Sensing - Select the “Enable solvent level sensing” check box to enable this 
feature (recommended). 

Clear this box to disable this feature. The solvent level sensing feature will monitor solvent 
usage to minimize the risk of running out of solvent during a purification run. The system 
compares the volume required for a purification run with the estimated volume in the solvent 
container and alerts you when there is not enough. 

 N ot Note

If the Torrent is connected to pressurized lines, disable solvent level sensing. 

If using the solvent level sensing feature, enter the Minimum Solvent Level (density 
dependent) as a range in centimeters. 

To understand this range, consider that dichloromethane is more dense than hexane. If the 
selected range is 1-4, the system triggers an alert when the dichloromethane level rises to 
about 1 cm above the tip of the level sense line. At the same selected range, the system would 
trigger an alert when the hexane rises to about 4 cm above the tip of the level sense line. 

Waste Level Sensing - The Torrent can detect full container conditions if the air line is placed 
in the waste collection container. If waste level detection is desired, enable the waste level 
sensing feature (recommended). Otherwise, uncheck this option to disable this feature. 

Solvent B Priming Pump - Select the “Enable solvent B priming pump” check box to enable 
this feature (recommended). Clear this box to disable this feature. 

The Torrent is equipped with a priming pump for the B solvent to ensure that the system forms 
repeatable gradients. This pump can be enabled or disabled.

 N ot Note

If the Torrent is connected to pressurized lines, disable the solvent B priming pump.

CombiFlash Torrent Name - (Optional) Use this option to name your system. The name will 
appear in operational displays and run summaries. This feature is useful when your laboratory 
has more than one Torrent.

Time Zone - Select your time zone from the drop-down list box. 

Set Date/Time - Click this button to open a window from which you can set the system date 
and time. 

To prevent unauthorized time changes, this feature is password protected. The system is 
shipped with the password set to combiflash. Use the Tools>Set Password menu command to 
change this password for greater security. 

Vapor Limit - The Torrent has an internal vapor sensor that detects vapors present in the 
Torrent. When the limit is exceeded, the Torrent will shut down to avoid a hazardous condition. 
Teledyne ISCO recommends using the default setting of 12. This value represents an organic 
vapor level slightly above the ambient vapor level of a well-ventilated laboratory. 

A setting below 12 could cause random alarms without significant vapors present. If PeakTrak 
displays a Vapor Limit alarm while the Vapor Limit is set at 12, perform the following checks 
on your laboratory and the instrument:
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• Ensure that no open containers or spills of organic solvent are in close proximity to the 
Torrent. 

• Ensure that the Torrent is located in a well-ventilated area.

• Ensure that there is no visible solvent leakage from the Torrent.

If PeakTrak continues to display the Vapor Limit alarm after you have made these checks 
and corrected any problems found, it is likely that organic vapors are present in the ambient 
environment of your laboratory. In this case, increase the setting of the Vapor Limit. Settings 
greater than 12 are appropriate for laboratory environments with a somewhat elevated 
background solvent vapor concentration, representing a safe setting, but one with a reduced 
margin for error. 

Set Default Tube Volumes - Click this button to open a window from which you can set the 
default volume of the collection tubes. You can increase or decrease these values to set the 
desired default volume collected in each container. Be sure you do not overflow the containers 
by exceeding their capacity.

 N ot Note

The maximum fraction volume allowed to be entered on the system is 99,999 mL. Also, if doing 
multiple injections and using a fractionation valve or funnel rack, the system does not track the 
cumulative volume from run to run, it resets after each injection. So be sure your receiving vessel 
is large enough to hold the fraction volume over multiple runs.

The system will automatically advance to the next tube (or container when using the 
Fractionation Valve) when this default volume is met in each tube. Keep in mind that 
advanced method settings (discussed in Section 3 and the on-line help) may override this 
default setting. During a run, other factors such as automatic tube advances for detected 
peaks will affect collected volume. 

3.1.2  Network Configuration
Network Configuration can be found under: TOOLS > CONFIGURATION >NETWORK 
CONFIGURATION and is used if you want to connect the system to a network. By doing so, 
you can remotely view the user interface for monitoring or controlling the system, print to a 
network printer, or automatically save data files right to the network.

To connect to a network, you will need access to IP addresses and network information from 
your IT department. For more information on network guidelines, see TN28 Networking 
Guidelines for CombiFlash Products available at www.isco.com.

3.1.3  User Preferences
Use the User Preferences tab to configure system operation for each user. Select a user from 
the drop-down list and configure the following:

 N ot Note

New systems will only have one user account named “common.”

Language - Select the user's desired language from the drop-down list box. 
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Automatically Print Report at End of Run - if this option is enabled, the system will print 
a report at the end of each run. 

 N ot Note

This option requires the system to be configured for network operation and a connection to a printer 
on the network. Network settings are discussed in Section 5, REMOTE INTERFACES. Do not 
select this option for these initial installation steps.

Beeper - If enabled, the Torrent will sound an alert whenever user intervention is required 
during a run. 

Default Run Units - Run units are displayed along the X-axis of the chromatogram. Select 
Time (in minutes) or Column Volumes. A column volume unit is the time it takes to pump 
enough solvent to exchange the volume held by the column. The duration in minutes will vary 
according to the column media and size, and the flow rate. 

Gradient Method - Select the standard gradient type

Figure 3-2  Gradient types

• Linear - The system gradually mixes solvents A and B from the last programmed %B until 
it reaches the next programmed %B. This method connects the inflection points that 
define the gradient with a straight line. 

• Step - The system holds each %B value until it reaches the next programmed %B. Because 
the system holds the %B values, the changes at each new value are nearly instantaneous, 
producing a stepped appearance on the plot area. 

• Isocratic - The system holds the initial solvent mix for the entire run. 

 N ot Note

The System Verification procedure (section 2.15) requires a Linear gradient method.

Enable Run Length Extension - When enabled, this option automatically extends the run if 
a peak is eluting at the end of the maximum %B gradient. This ensures that a late-eluting peak 
fully comes off the column and is collected. 

An automatic run extension is a five-minute Isocratic hold added to the end of the run's 
maximum %B gradient profile. During the extension, the system continues to pump the 
maximum %B solvent mixture. Should the system still detect a peak after an extension, the 
system will add another, up to a maximum of three extensions. 
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Occasionally, compounds might come off the column once the %B returns to the minimum 
value at the end of a run. If the Run Length Extension is enabled, it will automatically extend 
the run one time to clear the column and plumbing of any remaining material.

Figure 3-3  Automatic Run Extension Examples

Figure 2-21 illustrates the possible run extensions. The original method was programmed to 
rise to the maximum %B over seven minutes, hold for two minutes and return to the 
minimum %B for a final minute. At nine minutes, a peak was eluting. PeakTrak extended the 
run, holding the %B at the maximum level for another five minutes. This also occurred at 
fourteen and nineteen minutes, resulting in the second and third extensions. At 24 minutes, 
the %B solvent strength returned to zero. Before the final minute elapsed, more compound 
was detected, causing PeakTrak to extend the run for a final five minutes at the minimum 
%B. 

Enable rapid equilibration - select this option to equilibrate the column at a high flow 
rate. Due to the high pressure that is possible during rapid equilibration, this option may not 
be desirable for some column media or purification methods. 

3.1.4  Fraction Collector
 Use this tab to configure the Torrent to control up to four Foxy R2 High Flow fraction 
collectors. This tab is also used to configure the Torrent for use with a Fractionation Valve. 
Foxy fraction collector(s) should be connected to the Torrent via a straight-through network 
cable. To communicate with each fraction collector, the IP address settings on this tab must 
match the IP address set in each fraction collector. Note that all IP addresses must be unique. 
Refer to the fraction collector user manual to set the address of each module. 

 N ot Note

The optional Foxy R2 High Flow fraction collector does not support DHCP. If you are adding the 
Torrent module with optional Foxy R2 High Flow fraction collectors to your organization's network, 
a static IP address must be assigned to each fraction collector. Contact your IT department for 
assistance.

A delay volume must also be specified for each Foxy connected as a system. If using the 
Fractionation Valve instead, a delay volume should also be entered. The delay volume entries 
ensure that the tube changes occur when the peak fluids are present at the fraction collector 
diverter valve. 
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If using the factory-cut tubing provided with the Foxy R2 High Flow fraction collectors or 
Fractionation Valve, enter the following as applicable: 

Foxy 1 Delay Volume - 20 mL

Foxy 2 Delay Volume - 40 mL

Foxy 3 Delay Volume - 60 mL

Foxy 4 Delay Volume - 80 mL

Fractionation Valve Delay Volume - 10 mL

If using custom-length tubing, calculate the delay volume of all tubing between the Torrent's 
TO COLLECTOR port and the diverter valve inlet using the formula: 

V = π / 4 x D2 x L 
(otherwise expressed as: V= 0.7854 x D2 x L), 

where L is the tubing length (cm) and D is the inside diameter (cm). The resulting volume is in 
milliliters. 

Fractionation Valve Configuration - If using the Fractionation Valve, enable the 
Fractionation Valve option and enter a delay volume. The delay volume entries ensure that the 
tube changes occur when the peak fluids are present at the fraction collector diverter valve. You 
can calculate the delay volume using the formula above.

3.1.5  Restart the system
Some configuration settings do not take effect until the system is restarted. After completing 
sections 2.13.1 through 2.13.3 restart the system: 

1. If the Configuration window is not closed already, click the OK button to close it. 

2.Place the Power switch below the LCD display in the Off position and wait one minute or 
more. 

CAUTION

Always wait at least one minute after placing the Power switch in the Off position. Moving 
the switch to the Off position begins a power down sequence that takes up to one minute to 
complete. If you move the switch to the ON position before the sequence is complete, the 
system may not start up correctly.

CAUTION

Except during an emergency, never remove AC power immediately after placing the Power 
switch in the Off position. The power down sequence includes file maintenance that takes 
up to one minute to complete. Interrupting the file maintenance may corrupt files causing 
abnormal operation or a complete system failure. 

3.After one minute or more, place the Power switch in the On position. 

4.The Torrent is ready for operation when the PeakTrak screen is displayed.
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3.1.6  Configuration
The Configuration window allows you to define the operating characteristics of your 
CombiFlash Torrent module. It also allows you to configure the module for network 
connections for remote access and printing. Open the Configuration window by selecting the 
TOOLS>MANUAL CONTROL menu command.

The configuration window displays four tabs: INSTRUMENT CONFIGURATION, NETWORK 
CONFIGURATION, and USER PREFERENCES, FRACTION COLLECTOR.

3.1.6.1  Instrument Configuration

Solvent Controls

• Add Solvent — Click this button to enter a solvent name. PeakTrak can store up to 16 
solvent names. For assistance in selecting appropriate solvents, see the SOLVENT SELECT 
VALVE (IF PURCHASED).

• Remove Solvent — Click this button to open a list of all entered solvent names. Select 
the names you want to remove and then click the OK button.

• Enable Solvent Level Sensing — If this option is selected, the module will check the 
solvent levels before and during a run. PeakTrak will alert you if a solvent level becomes 
too low. Note that the solvent level monitoring option does not control the operation of 
Waste Solvent Level monitoring. Waste level sensing is always enabled at the beginning 
of a run.

• Minimum Solvent Level — This value is density-dependent, thus a range is given. To 
understand the range, consider that dichloromethane is more dense than hexane. If the 
selected range is 1–4, an alert would be triggered when the dichloromethane falls to 
about 1 cm above the bottom of the weighted filter. At the same selected range, an alert 
would be triggered when the hexane solvent level falls to about 4 cm above the weighted 
filter.

• Waste Level Sensing — The module can detect full container conditions if the air line 
is placed in the waste collection container. If waste level detection is desired enable the 
waste level sensing feature (recommended). Otherwise, uncheck this option to disable 
this feature. 

Enable solvent B priming pump (Torrent only)— The CombiFlash Torrent module is 
equipped with a priming pump for the B solvent to ensure that the system forms repeatable 
gradients. This pump can be enabled or disabled if using with the Solvent Selection valve, 
this should be disabled and the B Prime Port should be capped with plug (P/N 209-0165-21, in 
accessory kit 60-5249-002). Note, that the system should be AutoPrimed before use to ensure 
repeatable gradients. 

CombiFlash Torrent Name Enter a name for the module. This name will appear in the 
title bar of the Main window. The name will also appear in run summaries. Unique names are 
helpful when operating more than one CombiFlash Torrent module in your lab.

Time Zone Select your local time zone.

Set Date/Time Click this button to set the date and time. From the touch screen, this 
command opens a window that allows you to set the instrument date and time. If you select 
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this command from a remotely connected computer, this menu command automatically sets the 
module time to match the computer’s.

Note: The module will restart after you set the time. 

To prevent unauthorized time changes, this feature is password protected. See also: SET 
PASSWORD.

Vapor Limit Type or select the vapor limit setting. The CombiFlash Torrent module’s 
internal vapor sensor detects vapors present in the module. When this value is exceeded, the 
module will shut down to avoid a hazardous condition. For more information, refer to SETTING 
THE VAPOR LIMIT.

Set Default Tube Volume Click this button to open a window from which you can set the 
default volume of the collection tubes. You can increase or decrease these values to set the 
desired default volume collected in each container. Ensure that you do not enter a value that 
exceeds the container’s capacity. This will overfill the container. 

The Foxy fraction collector will automatically advance to the next tube when this default 
volume is met in each tube. Keep in mind that the PEAK COLLECTION BUTTONS settings on the 
METHOD EDITOR window may override this default volume. During a run, other factors such as 
automatic tube advances for detected peaks will affect collected volume.

3.1.6.2  Network Configuration

Network configurations settings require assistance from your network administrator. Contact 
your Information Technology department before changing the settings.

Instrument IP Address Configuration

Use these settings to specify the instrument’s network address and its parameters:

• Network Type — Select the “Static IP” option. 

This option will require an IP Address, Netmask, and Gateway provided by your network 
administrator.

• IP Address — Enter the static IP Address for the module.

 N ot Note

The module also provides limited support for DCHP connections. If DHCP is desired, select DCHP 
as the network type and follow the displayed instructions to complete the connection.

• Netmask — Enter the Netmask for the module.

• Gateway — Enter the Gateway for the module.

Network Printing The module can print to a network printer and supports JetDirect and 
line printer (LPR) queues.

Consult with your network administrator to determine the IP address of selected printer. If the 
printer uses an LPR print queue, you must also find out the queue name. If the printer uses a 
JetDirect print queue, also ask for the port number. When this information is known, you can 
proceed with configuring module for network printing.
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Follow the on-screen instructions for entering the address and queue information. After 
successfully printing a test page, the network printer will be available for printing using the 
FILE>PRINT menu command and the AUTOMATICALLY PRINT REPORT AT END OF RUN feature. 

The Network printing controls may also be configured to print to a local USB printer 
connected the system’s back panel USB port. The printer must support postscript printing. To 
configure the local printer, select Postscript for the Printer Type. Then, type the following 
connection URL: “usb:/dev/usb/lp0”.

Network File Save Configuration When configured, this feature allows the module to 
access a network directory from which it can save run files as PDF, text, or run monitor. To 
enable this feature, select a file type to be saved and enter the remaining settings necessary 
for network access. Your network administrator will be able to provide the required settings. 

NOTE: All server and domain names must be fully qualified. That is, entries must include 
the full name (server name.domain.domain…). Use forward slashes (/), not back slashes, 
when entering the network share path. 

3.1.6.3  User Preferences

Language Select the language for PeakTrak.

Automatically Print Report at End of Run If this option is enabled, the module will 
print a completed run report using the NETWORK PRINTING feature. 

Beeper If enabled, the Torrent module will sound an alert whenever user intervention is 
required during a run.

Default Run Units Run units are displayed along the X-axis of the chromatogram. Select 
“Time, Minutes” or COLUMN VOLUMES (CV) run units to be displayed on program settings and 
chromatogram displays. 

Enable Run Length Extension When enabled, this option automatically extends the run 
if a peak is eluting at the end of the programmed run length. This ensures that a late-eluting 
peak is still collected.

Gradient Method Select the desired gradient method option.

• If the Linear method is selected, solvents A and B will be mixed gradually from the last 
programmed %B until the next programmed %B is reached. This method connects the 
inflection points that define the gradient with a straight line.

• If the Step method is selected, each %B value is held until the next programmed %B is 
reached. Because the %B values are held, the changes at each new value are nearly 
instantaneous, producing a stepped appearance on the plot area.

• If Isocratic is selected, the module will pump a single %B mix throughout the run.

Enable Rapid Equilibration Select this option to turn on rapid equilibration. When 
enabled, this time-saving feature pumps solvent at the maximum flow rate during column 
equilibration. Note that some column sizes and types might be adversely affected by high 
flow rates.
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3.1.6.4  Fraction Collector
Use this tab to configure the CombiFlash Torrent module to control up to four Foxy R2 High 
Flow fraction collectors. This tab is also used to configure the module for use with a 
Fractionation Valve. 

Foxy fraction collector(s) should be connected to the module via an Ethernet cable. To 
communicate with each fraction collector, the IP address settings on this tab must match the IP 
address set in each fraction collector. Note that all IP addresses must be unique.

 N ot Note

The optional Foxy R2 High Flow fraction collector does not support DHCP. If you are adding the 
Torrent module with optional Foxy R2 High Flow fraction collectors to your organization’s network, a 
static IP address must be assigned to each fraction collector. Contact your IT department for 
assistance.

A delay volume must also be specified for each Foxy fraction collector connected as a system. If 
using the Fractionation Valve instead, a delay volume should also be entered. The delay volume 
entries ensure that the tube changes occur when the peak fluids are present at the fraction 
collector diverter valve. 

If using the tubing provided with the Foxy R2 High Flow fraction collectors or Fractionation 
Valve, enter the following as applicable: 

• Foxy 1 Delay Volume - 20 mL

• Foxy 2 Delay Volume - 40 mL

• Foxy 3 Delay Volume - 60 mL

• Foxy 4 Delay Volume - 80 mL

Fractionation Valve Delay Volume - 10 mL

If using custom-length tubing, calculate the delay volume use the formula:

V = pi / 4 x D2 x L 
(otherwise expressed as: V= 0.7854 x D2 x L), 

where L is the tubing length (cm) and D is the inside diameter (cm). The resulting volume is in 
milliliters.

Fractionation Valve Configuration If using the Fractionation Valve, enable the 
Fractionation Valve option and enter a delay volume. The delay volume entries ensure that the 
tube changes occur when the peak fluids are present at the fraction collector diverter valve. You 
can calculate the delay volume using the formula in the Fraction Collector topic. 

3.1.7  Set Password
This window, opened by selecting the TOOLS>SET PASSWORD menu command, is used to enter 
and change the module password, and to enable password protection for the default methods.

To enter or change a password:

1.Type the password.

2.Type the password again to verify your entry.
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3.To protect the Default methods select the “Require Password For Editing Default Methods” 
option.

4.Click the OK button to save your settings and close the window.

The following menu commands will require a password before displaying the requested 
window:

• TOOLS>EDIT DEFAULTS 

• TOOLS>USER MANAGEMENT

• HELP>SERVICE 

• TOOLS>SET PASSWORD. This protects the current password.

3.1.8  User Management
Use the TOOLS>USER MANAGEMENT menu command to open a window from which you can 
add and remove module users. When you add a user, PeakTrak will create a user folder that 
becomes the data path for that user. User management, in conjunction with this data path 
feature, conveniently lets you store your working files apart from other module users.

To add a user, click the Add New button and enter the user name. To delete a user, click the 
Delete button next to the user’s name and confirm the action. For more information please 
see section 5.2.3.8 User Management.

Figure 3-5  User Management Screen
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Section 4 Operation

This section provides abbreviated operating instructions for the CombiFlash Torrent module. 
For complete instructions, refer to Help menu option from PeakTrak’s main menu.Sample 
Preparation

Before starting a run, consider how the sample will be introduced to the column media. This 
section discusses three methods: liquid injection, solid sample cartridges, and preloading the 
sample on the column. 

4.1  Sample Introduction

4.1.1  Liquid Sample Injection
If the sample is soluble in the starting mobile phase, it can be prepared and introduced as a 
solution. There are three different methods to introduce liquid samples to the Torrent.

1.Syringe injection onto the column (see Section 4.3.1).

2.Loaded via Sample Load Pump (see Section 4.3.2).

3.Loaded via Solvent Select Valve through Sample inlet line (see Section 4.4.3).

4.1.2  Solid Samples
Some compounds are not soluble in solvents that are compatible with the chromatography. In 
addition, the compounds may have very limited solubility in any solvent, resulting in sample 
volumes that are impractical for good chromatography. The answer in this case is solid 
sample introduction. Here the reaction mixture or dissolved sample is mixed with the same 
media in the chromatography column. 

Some samples of this type may be simply dissolved and placed into a prefilled cartridge. You 
can then use the cartridge immediately or dry it before placing it on the system. 

Other samples may need more care. Typically you would create a mixture of 20% sample load 
to media (w/w). Then dry the mixture under conditions that will drive off the solvent without 
affecting the compounds of interest. These compounds remain bound to the media. Once 
dried, pour the media/sample mixture into an empty cartridge.

To prepare an empty solid sample cartridge:

1.Ensure the empty cartridge has a bottom frit.

CAUTION

Missing frits may cause equipment damage, UV detection problems, or increased 
maintenance. Frits prevent solids from entering the fluid path.

2.Prepare the media and sample:
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3.Dissolve your sample in a minimal amount of a suitable, volatile solvent.

4.Place the media into the solvent. If using silica gel, a particle size of 40–60 µm (240–400 
mesh) is recommended. The amount of silica required is about four to five times the mass of 
your sample.

5.Agitate the solvent for a moment to allow the sample to adsorb to the silica.

6.Remove the solvent with a suitable method, such as rotary evaporation. Alternatively, you 
can dry the prepared cartridge after step 9 by drawing the solvent out using a vacuum or 
using the Torrent’s air purge. 

7.Load the media and sample mixture into the cartridge. Tap the cartridge on the benchtop to 
settle the mixture.

8.Place a frit on the top of the cartridge. Force the frit down against the mixture using the 
plastic plunger.

9.Wipe away any residual powder inside the neck and top rim of the cartridge.

 N ot Note

You can remove solvent from a prepared cartridge by attaching the cartridge cap and manually 
purging (TOOLS>MANUAL CONTROL) the cartridge with air. 

 N ot Note

Empty solid sample cartridges also allow a variety of adsorbents, such as diatomaceous earth, 
boiling chips, cotton balls, or paper wipes. Even with alternative adsorbents, always use top and 
bottom frits to prevent fluid path problems.

After you have prepared the pre-filled or empty cartridge, place the solid sample cartridge on 
the system:

1.Attach the desired adjustable cartridge cap:

• 60-5237-048, fits 12 and 20 gram solid load cartridges. 

• 60-5237-044, fits 32 and 65 gram solid load cartridges. 

• 60-5247-008, fits 125 and 260 gram solid load cartridges.

• 60-5247-009, fits 750 gram solid load cartridges. 

2.Press the lever on the side of the cap and fully extend the plunger (Figure 4-1). 

Figure 4-1  Press the lever and extend the plunger

1

2



Section 4  Operation

4-3

EAR99 Technology Subject to Restrictions Contained on the Cover Page

3.Slide the plunger into the cartridge until it reaches the top frit (Figure 4-2).

4.Press the lever and push the cartridge into the cap. Align the cartridge so that it fits fully 
into the recess in the cap (Figure 4-3).

5.Load the solid sample cartridge with cap on the sample injection port.

CAUTION

Pinch point. Your fingers or hands can be seriously injured if you place them between the 
moving parts of the Solid Load Cartridge Cap Mount or the Upper Column Mount. Use care 
when installing solid load cartridges or columns.

4.1.3  Preloading on Column
You can load the reaction mixture or sample directly onto the column, sometimes called 
“direct” or “dry” loading. 

 N ot Note

If using this method, use care to ensure that a column equilibration does not wash away the 
sample. Bypass the column equilibration at run time by selecting “Preload on column” as the 
sample Loading Type. Refer to Section 4.3 for more details.

Figure 4-2  Insert the plunger to the bed
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Figure 4-3  Align and push cartridge into the cap, and then rotate the cartridge to secure it. 

4.2  Loading a RediSep Rf Column
To load a RediSep Rf column:

WARNING

The CombiFlash Torrent has redundant safety devices to limit pressure to less than 100 psi 
(689 kPa). RediSep columns smaller than 100 g are CE certified using standard IEC61010-1 
for use on the CombiFlash Torrent. RediSep columns larger than 100 g meet Pressure Vessel 
Directive 97/23/EC. Teledyne ISCO strongly recommends against the use of columns rated 
less than 100 psi (689 kPa).

 N ot Note

For best results, always use RediSep Rf columns. The system will not automatically detect other 
columns, including non-Rf RediSep columns. The system also limits the maximum operating 
pressure to 50 psi when the column is not detected. 

1.Select the proper RediSep Rf column. The RediSep column selection guide that can assist 
you in selecting a stationary phase media and column size. In addition, the approximate 
sample loading capacity is printed on the RediSep column label

CAUTION

Pinch point. Your fingers or hands can be seriously injured if you place them between the 
moving parts of the Solid Load Cartridge Cap Mount or the Upper Column Mount. Use care 
when installing solid load cartridges or columns.

2.Raise the upper column mount until it is held by the latch.

3. Insert the column onto the lower column mount. 

4.Firmly grasp the upper column mount, raise it, and then push the latch to the left to release 
it.

5.Slowly lower the column mount and align it with the column inlet. The spring-loaded mount 
will secure the column in place.

1

2
3
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6.Rotate the column 14 turn to seal the fittings.

 N ot Note

After loading a RediSep Rf column, the system will use RFID technology to automatically detect 
the media type and column size. PeakTrak displays the detected column size on the Main and 
Method Editor windows. If the system does not detect the column, manually select the column 
media and size.

4.3  Start a Default Method
After completing the system installation steps (see Section 2), preparing the sample, and 
inserting the column, you are ready to perform a run with the default method. The Torrent’s 
default methods are factory-set with run parameters typically used by chemists. Default 
methods are optimized for RediSep Rf columns. The default settings will:

• Pre-configure equilibration settings based upon column size and type.

• Set a flow rate and separation length suitable for the column loaded.

• Set to collect all fluid in the fraction collector rack to ensure peaks without UV 
absorbency are collected.

• Pre-program peak detection settings suitable for typical peak sizes based on the column 
size.

Automatically advance to the next tube when a peak is detected and when a peak ends to 
maximize peak concentration.

Advance to the next tube if a partially resolved peak has a shoulder or valley UV absorbing 
peaks based on slope detection or level threshold.

To start the run from the PeakTrak Main window:

1.Enter a sample name. If you choose not to, PeakTrak will enter the date and time as the 
sample name when you start the run.

2.Review the PEAKTRAK MAIN window settings. Some settings can be edited from the 
main menu. For example:

• The duration of the run can be adjusted using the RUN LENGTH input field.

•  The gradient slope can be adjusted by grabbing an inflection point and dragging to 
the desired position.

•  Inflection points can be added or deleted if needed. Select the ADD POINT button 
and touch the screen where a point should be added, or DELETE POINT and touch 
the point to be removed.

•  For greater detail, the screen can be zoomed using a 2-finger pinch zoom, or panned 
using 2 fingers.

• Other parameters may be edited such as peak detection parameters or numerical 
gradient point input using the METHOD EDITOR selection at the top of the screen.

3.Click the Play button.

4.Select the sample Loading Type from the list. This Loading Type should support the 
sample preparation you chose in Section . Possible sample loading types are:
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Figure 4-4  Loading Options Screen

• Automatic – Select this option if you have prepared a liquid sample and plan to use the 
Solvent Select Valve automatically load the sample after column equilibration. The 
Torrent will then do a series of injections. (see Section 4.4.3). 

• Solid (Pause) – Select this option if you intend place the sample into a solid sample 
load cartridge, but have not yet prepared the sample. When you click the run button, 
the system will perform a column equilibration and then wait while you prepare the 
cartridge. After you have placed the cartridge on the system, click OK to continue with 
the run. 

• Solid – Select this option if you already have prepared the sample and placed it into a 
solid sample load cartridge. The system will proceed automatically until the end of the 
programmed run.

• Liquid – Select this option if you have prepared a liquid sample and plan to manually 
inject it or pump into the injection port after column equilibration.

• None (on column) – Select this option if you have preloaded the sample on the 
column. The system will skip column equilibration so that the sample will not be 
flushed from the column before the run.

5.Review or update the Start Rack and Start Tube settings.

6.Review the Minimum Run Requirements. The system will report the estimated solvent 
volumes, expected waste, collection tube usage, etc. You can use this information to verify 
that there will be enough solvent to complete the run, the waste volume does not exceed the 
collection container’s capacity, and whether or not more collection tubes will be required 
during the run.

 N ot Note

The Torrent estimates the solvent volumes by monitoring the solvent level in the container and the 
known usage rate. The systems continue to refine this estimate during operation. 

 N ot Note

If the waste level sensing tube is inserted correctly into the waste container, the Torrent will 
automatically suspend operation before an overflow condition might exist. To prevent the run from being 
suspended before completing the run, ensure that the container will hold the expected waste volume. 
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7.Click OK and the run begins. The system responds according to the sample Loading Type 
you selected in step 4. 

• If you selected Solid (Pause), the system equilibrates the column with the starting 
%B solvent mixture and then waits while you prepare the solid sample load cartridge. 
When prompted, place the cartridge on the system and click OK to continue. 

• If you selected Solid, the system equilibrates the column and immediately starts the 
separation. The prepared solid load cartridge should be in place before clicking the OK 
button.

• If you selected None (on Column), the system skips the equilibration and 
immediately starts the separation. The sample must be on the column before clicking 
the OK button. 

• If you selected Liquid, the system equilibrates the column and then waits. When 
instructed, load the liquid sample using the syringe injection (4.3.1) or the Sample 
Load Pump (4.3.2) options.

4.3.1  Syringe Injection
Refer to Figure 4-5 for the following steps. 

1.Connect the Liquid Injection Adapter from the accessory kit to the Sample Injection Port. 

2.Place the syringe on top of the Liquid Injection Adapter valve.

Figure 4-5  Liquid Injection Adapter

3.Open the valve.

4. Inject the liquid sample mixture.

5.Close the valve and remove the syringe.

 N ot Note

Chase solvent clears the Liquid Injection Adapter tubing and forces the liquid compound mixture 
onto the column. Without the chase solvent, some of the sample will remain in the tubing before 
the automated injection valve and will not be separated. This small amount of sample may also 
cross-contaminate the next purification run. The chase solvent should be strong enough to 
prevent the sample from precipitating (or crashing), but not so strong as to adversely affect the 
separation of compounds. Often, the initial liquid phase solvent is a practical chase solvent.

Closed: handle
perpendicular

to tubing

Open: handle
in-line with tubing
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6. Inject a chase solvent:

7.Connect a syringe loaded with a chase solvent to the Liquid Injection Adapter’s luer fitting.

8.Open the valve by turning the handle so it is in line with the tubing.

9. Inject at least 10 mL of the chase solvent.

10.Close the valve by turning the handle so that it is perpendicular to the tubing. Remove the 
syringe.

11.Click the OK button to continue the run.

 N ot Note

Chase solvent will remain in the line up to the automated injection valve. Keep in mind that this 
solvent may affect the next injection. 

4.3.2  Sample Load Pump
1.Connect the outlet of the Sample Load pump to the Torrent’s Sample Injection Port.

 N ot Note

To bypass the injection valve, the sample may also be pumped onto to the column at the upper 
column mount. If this method is preferred, use the Direct Injection Adapter on the upper column 
mount to ease tubing changes. (see section 2.20.3.) 

Figure 4-6  Sample Load Pump options

2.Prepare the Sample Load pump to receive the sample.

If the sample mixture will be transferred to the pump, insert the cartridge onto the pump inlet (Figure 4-6, 
Left). Then, fill the cartridge with the mixture.

If you will transfer the sample mixture directly from a container, attach the tubing to the pump inlet (Figure 
4-6, Right). Place the weighted end into the mixture container.

3.Place the On/Off (I/O) switch in the On position. Adjust the pump speed using the control 
knob.

4.When the desired sample volume has been loaded, place the On/Off (I/O) switch in the Off 
position.

 N ot Note

After use, always pump clean solvent through the Sample Load Pump to remove sample residue. 
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 N ot Note

Some of the sample mixture will remain in the tubing before the automated injection valve. In 
most applications, pump a chase solution to force the sample mixture through the injection valve. 
To do so, repeat steps 2 through 4 using a suitable chase solvent.

4.3.3  Sample Loading Using the Solvent Select Valve
For accurate injection volume and consistent chromatography follow the below steps:

Before beginning the Run, the sample inlet line needs to be primed with sample liquid.

1.Open the manual control screen.

2.Choose SAMPLE from the Solvent B dropdown menu.

3. Input 60 mL/min for a flow rate and choose DIRECT TO WASTE for the Flow Path.

4.Press Prime B and observe the tubing carrying the sample from the sample bottle to the 
Solvent Select Valve (on top of the Torrent).

5.Press STOP once the sample line is purged of air and the sample liquid has reached the 
valve.

6.Close the manual control window.

7.Go to TOOLS and select AUTOPRIME and choose your initial B solvent and A solvent 
(this removes any air pulled into the system from the sample line during priming and 
ensures the plumbing is in the same state it would be in for future injections).

8.The injection parameters for the run may be set up under the SAMPLE LOADING menu 
in the METHOD EDITOR or set up at the beginning of the Run using the PLAY button.

9.Via either option to set up the injection for loading using the Solvent Select Valve:

10.Enter the total volume of sample to be injected over the course of all runs.

11.Enter the number of injections (the system will automatically calculate the injection 
volume per run based on the total volume entered).

12.Choose the flow rate during the sample injection period if different than the flow rate used 
in the method. (If sample liquid is more viscous than the mobile phases, it may be 
advantageous to load the column at a lower flow rate until all the sample is loaded onto the 
column to avoid any overpressure situations).

13.Press OK.

When using the Solvent Selection Valve to Load Sample, the following sequence is used by 
instrument for loading.

1.The system will perform equilibration of the column as defined in the method. The sample 
volume for the run will be loaded using the B pump at the injection flow rate. (Note: if the 
sample line has not been primed with sample, the first injection volume will be 
inaccurate.)

2.50 mL of B solvent (whichever B solvent is being used at the beginning of the run) to 
quickly clear the B pump head of any sample at the injection flow rate.

3.The run will begin at the flow rate and solvent composition as defined in the method editor.
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4.Once the run is complete, the next run will begin if multiple injections were programmed 
using the same sequence. 

Once the series of runs is completed using the Sample Loading feature of the Solvent Selection 
Valve, the sample line should be flushed and cleaned to prevent precipitation and 
contamination if it is not going to be immediately used for the same type of sample. 

1.Place the Sample Line into a vessel with a suitable wash solvent (the solvent being used for 
B is suitable, but in its own container to prevent contaminating the B solvent source). 

2.Go to Manual Control and select the SAMPLE as the B solvent and flush 200 mL of solvent 
direct to waste by pressing 100% B.

3.Remove the sample line from the bottle and let it pull air until it reaches the Solvent Select 
Valve.

 N ot Note

If using the SSV on a normal phase system, the dissolution solvent for the sample can't be greater 
than 90% alkanes (hexanes, heptane, cyclohexane, etc.) to prevent B pump seizing. Adding 
another non-alkane solvent (usually the B solvent) in a 10% ratio to the sample will prevent the B 
pump from seizing.

4.4  During the Separation
You can monitor the progress of the run on the PeakTrak main window. If desired, you can 
modify gradient parameters during the run. (See the Real-time Gradient Editing on-line help 
topic.)

As the run progresses, the absorbency trace is drawn on the Gradient Plot area. The separation 
or purification continues until the end of the run defined by the run length setting.

During the run, data is automatically saved every few seconds. PeakTrak automatically saves 
all run history on the system’s internal hard drive in its native .RUN format. You can manually 
save a Run file as Text or PDF while stopped or any later time as long as the .RUN file has not 
been deleted. Selected files can be manually saved to a connected Flash drive. To automatically 
save a Text or PDF file after each run, configure the Network File Save feature.

4.4.1  Run Control Buttons

Figure 4-7  Main Screen



Section 4  Operation

4-11

EAR99 Technology Subject to Restrictions Contained on the Cover Page

• Play — The Play button starts the run. During the run, other run control buttons are 
active.

• Pause — The Pause button holds the %B at the current value while the system 
continues to operate (sometimes called an Isocratic hold). Note that pausing the run 
extends the run length. While in the Paused state, you can resume the run by clicking 
the Play button, or stop the run by clicking the Stop button. If you resume the run, the 
system continues with the gradient curve at the %B when the system was paused.

• Stop — Stop, Fast Forward, and Rewind — The STOP button suspends the entire run. 
Unlike the paused state, the pump, peak detection, and fraction collection will stop. 
While in the stopped condition, you can:

• Resume the run by clicking the PLAY button, skip the rest of the separation by clicking 
the FAST FORWARD button which proceeds with the air purge (if the system is 
equipped with this feature) or end the run by clicking the REWIND button which clears 
the data from the screen and displays the now truncated temporary method.

The advantage of the FAST FORWARD vs. the REWIND is that the fast forward advances to 
the air purge line flush, and detector wash while REWIND performs none of these important 
maintenance functions.

If REWIND is selected, it may be useful to manually flush the lines so that strong solvent 
remaining in the lines doesn’t affect subsequent separations.When the Stop button is 
pressed, solvent remains in the tubing from the injection valve to the detector’s flow cell. 
Follow the steps listed below, according to your instrument’s configuration.

• Solid Sample Cartridge and air purge is enabled:
If you suspend the run with the Stop button, do not remove the column and/or solid 
sample cartridge without first pressing the Fast Forward button to purge solvents from 
all lines. If you stop the run because your peak of interest has been collected, protect the 
next user from being sprayed by solvents left in the lines by pressing Fast Forward so 
the instrument purges itself and is safe for its next use.

• Solid Sample Cartridge and air purge is NOT enabled, i.e. purge time set to 
zero in Method Editor:
If you suspend the run with the Stop button, remove the column and install the Prime 
Tube in place of the column. Manually purge the Sample Cartridge by pressing Tools -> 
Manual Control -> Air Purge Cartridge. Repeat this procedure for Air Purge Column.

• Liquid sample is loaded onto column and air purge is enabled:
If you suspend the run with the Stop button, remove the column and install the Prime 
Tube in its place. Press Fast Forward to purge all liquid lines.

• Liquid sample loaded onto column with air purge NOT enabled:
If you suspend the run with the Stop button, remove the column and install the Prime 
Tube in its place. Manually purge the liquid lines by pressing Tools -> Manual Control -> 
Air Purge Column.

• Next Tube — This button advances the fraction collector/fractionation valve to the next 
tube position. This allows you to conveniently collect eluate of interest in a new tube.

 N ot Note

When you click the Next Tube button, the system immediately marks the tube advance on the 
chromatogram. However, the system delays the movement of the drop former over the tubes. This 
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delay accounts for the volume held in the tubing between the detector and the drop former, 
sometimes called the “delay volume.” It is important to remember that the chromatogram displays 
activity in real time while the fraction collector activity lags behind. The duration of this delay will 
vary with the flow rate.

When this run is complete, the system will purge the column with air and clean the injection 
valve. Clicking the Fast Forward button will cause the system to skip any remaining time in 
the current step and advance to the beginning of the next step. Unlike the Rewind button, 
clicking the Fast Forward button to complete the run will not modify the current method’s run 
length setting.

 N ot Note

Solvent may be under pressure. Do not remove a column or solid load cartridge until the pressure 
gauge on the touch screen to return to 0 psi.

4.4.2  Bypassing the Solid Load Cartridge
Occasionally, impurities precipitate in the solid load cartridge as compounds are purified. This 
may cause high back pressures resulting in reduced flow rates and long run times. Clicking this 
button changes the injection valve position, which removes the cartridge from the solvent path 
and relieves the back pressure. Any compound that hasn’t eluted from the solid load cartridge 
will remain in the cartridge and not be purified.

4.4.3  About Solvent Level Sensing
When enabled in the TOOLS >CONFIGURATION window, the system will estimate the 
solvent volume usage by measuring the solvent level in the container and the monitoring the 
usage rate. The system continues to refine this estimate of available solvent during operation.

At the beginning of a run, the system calculates the amount of solvent required to complete the 
run. The system will alert you if it detects that there is not enough solvent at the start of the 
run. Likewise, the system will alert you during the run if the estimated usage rate or the 
measured level indicates that there is insufficient solvent. Note that pauses and automatic run 
extensions during a run will increase the required solvent volume.

The options available on the alert message will vary depending on when the condition occurs 
(before or during a run) and which method (measured level or estimated usage rate) indicated 
the condition.

To clear the alert message, the user must select one of the options below.

Continue – Select this option after you have added more solvent to the container. After 
selecting this option

the system measures the solvent level again. If the level is sufficient to complete the run, the 
run continues. If not sufficient, the system displays the alert message again.

Ignore – This option is available when the estimated usage rates indicates that the solvent 
levels are insufficient. Select IGNORE to clear the message and continue the run. The system 
then ignores the estimated solvent usage rate for the remainder of the run, but continues to 
measure the solvent level. Should the level become insufficient, the system will display another 
alert message.
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Disable – Select this option to turn off solvent level measurements and estimated solvent 
usage rates for the remainder of the run.

Cancel – This option appears before the run is started. Select this option to cancel the run 
and return to the main window which will display the current method.
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Section 5 PeakTrak

The CombiFlash Torrent module includes User Help topics that are available from the 
PeakTrak touchscreen or remote browser window. This section contains many of these topics 
that describe the PeakTrak interface and its use.

On-line Software Help benefits from linked text to navigate through topics of interest—a 
feature not available in printed manuals. For your convenience, linked text is displayed in 
SMALL CAPITALIZED TEXT, followed by the section number in brackets. Some topics are only 
available in the on-line help format.

5.1  PeakTrak Overview
PeakTrak is the control software for Teledyne ISCO’s CombiFlash Torrent module. This 
overview provides a description of:

• The PEAKTRAK WINDOW ELEMENTS

• The METHOD FILE

• The RUN FILE

• HOW TO GET PEAKTRAK HELP

5.1.1  PeakTrak Window Elements
The MAIN WINDOW displays the current METHOD FILE. From this window you can access 
many of PeakTrak’s features, view the module status, and view or edit the method file 
settings. The elements of the main window are the:

• Menu — The topmost item in the window is the PEAKTRAK MENU OPTIONS from which 
you can access all of PeakTrak’s features.

• System Status — PeakTrak displays the system status to the right of the menu. Status 
messages may include:

• The current operation mode

• current position in a run, expressed in time or column volumes

• current %B solvent mix

• peak status

• flow rate

• current time and date.

• Main region — This area is where you can view or modify method file settings. 
Frequently used method settings are displayed on the MAIN WINDOW. Advanced method 
settings are displayed on the METHOD EDITOR window.
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Many of the PEAKTRAK WINDOWS contain these main elements, or a subset of them. Note that 
the available commands and options will change according to the active window, the state of 
the module, and the current file.

Figure 5-1  Torrent Main Screen

5.1.2  Method File
PeakTrak controls the separation runs performed by the system through a Method file. The 
system uses the method file to direct the module operation after you click the Play button.

PeakTrak categorizes the method settings as Basic or Advanced. Basic settings are the 
frequently used controls accessed through the MAIN WINDOW. Use the METHOD EDITOR window 
to access the Advanced settings.

Method files are stored by the system and can be opened for review, reuse, or modification. To 
open a method file, use the FILE>OPEN menu command. Method files can be transferred to the 
module from an external storage device using the FILE>IMPORT METHOD menu command. 
Method files use an *.mtd filename extension.

5.1.3  Default Methods
When PeakTrak is started, and every time you insert a RediSep Rf column, the module loads a 
default method. A default method contains Teledyne ISCO’s recommended basic and advanced 
settings for the use of RediSep Rf columns on the module. There is a default method for each 
size and media type of RediSep Rf column.

Default methods provide a starting point for your separation or purification. From these initial 
settings, you can perform a purification run, or you can modify the settings for your next run. 
Subsequent runs will use the settings in the active window. If you have modified the settings, 
you can save the method file for future use.

If you find that the default methods are not a practical starting point for your applications, the 
default methods can be changed to meet your specific requirements. See EDITING A DEFAULT 
METHOD. 

5.1.4  Run File
When the module has finished a run, it saves the run history in a Run file. The history includes 
the METHOD FILE settings, collection point information, and a chromatogram. You can open and 
review the Run files stored by the module. To open a Run file, use the FILE>Open 5.2.1.2  menu 
command. Run files use an *.run filename extension.



Section 5  PeakTrak

5-3

EAR99 Technology Subject to Restrictions Contained on the Cover Page

 N ot Note

When using the Automated Sample Loading process with the optional Solvent Select Valve, it will 
automatically sequence the runs with the same file name, with -l1, -l2, -3, -l... for each injection in 
the sequence.

5.1.5  How to get PeakTrak help
PeakTrak help can be displayed by selecting Help>Help from PeakTrak’s menu.

If you need additional help, refer to Teledyne ISCO’s FOR ADDITIONAL INFORMATION.

5.2  PeakTrak Menu Options
PeakTrak menus include:

• FILE 

• METHOD EDITOR

• TOOLS

• HELP

5.2.1  File
The file menu lists the following commands:

Figure 5-2  File Menu Screen

5.2.1.1  New
Choose the New command to open a new method file. PeakTrak will open the main window 
using the default program settings for the detected column size.

5.2.1.2  Open
Choose this command to open a METHOD FILE (.mtd) or a RUN FILE (.run) stored on the 
module’s internal hard drive.

5.2.1.3  Manage Files
Choose this command to open a window from which you can archive or delete method and run 
files from the current directory. You can archive files by connecting a USB Flash drive and 
selecting the Copy or Move files to flash drive option.
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• To remove a file from the internal hard drive, highlight the file or enter the filename and 
click the Delete button. 

• To remove multiple files, click the Delete by Age button. Then specify the age limit in 
months and click OK.

 N ot Note

Use the Move and Delete options with caution as the files cannot be recovered from the internal 
hard drive once the action is complete.

5.2.1.4  Set Data Path
This opens the SET DATA PATH window. Use this window to specify the default storage folders 
for users. These folders contain multiple METHOD FILE and RUN FILE resources created by 
module users. (See also USER MANAGEMENT.)

5.2.1.5  Save Method
Choose this menu command to save the settings of the current method file to the module’s 
internal storage. The file will be saved under the current file name.

 N ot Note

DEFAULT METHODS are an exception and cannot be overwritten by the Save Method command. If a 
default method is open and you attempt to save any modifications to that method, the FILES window 
appears so you can rename the method file. This preserves the default method. If you do wish to 
edit and save the module’s default methods, use the “TOOLS>EDIT DEFAULTS” command instead.

5.2.1.6  Save Method As
Choose this command to open the FILES window. From this window you can rename the current 
method and save it on the module’s internal hard drive.

The Save Method As command also can scale a method to a different column size. To scale a 
method, select the scale option and select the new column size from the drop-down list. Then, 
click the Save button. The module saves a new method file with the gradient and run length 
scaled to the selected column size.

5.2.1.7  Save Run As PDF
Choose this command to save the displayed run on a remote computer’s hard drive or a USB 
Flash storage device connected to the module. When selecting this menu command from the 
touch screen, the module saves the file on the USB storage device. The file name will be the 
same as the Run file, except with a “PDF” file name extension. When selecting this command 
from a remotely connected computer via a web browser, PeakTrak displays a file download 
window so you can select a location and enter a file name.

(You can open and print PDF files with Adobe Reader.)

5.2.1.8  Save Run As TXT
Choose this command to save the displayed run on a remote computer’s hard drive or a USB 
Flash storage device connected to the module. When selecting this menu command from the 
touch screen, the module saves the file on the USB drive. The file name will be the same as the 
Run file, except with a “TXT” file name extension. When selecting this command from a 
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remotely connected computer via a web browser, PeakTrak displays a file download window 
so you can select a location and enter a file name.

(You can open, edit, and print TXT files with text editing or word processing software.)

5.2.1.9  Import Method
Choose this command to load a Method file from an external source (see EXPORT METHOD) 
onto the module’s internal storage. From the touch screen, this command opens the FILES 
window so you can locate and select the file on a USB Flash storage device. When selecting 
this command from a remotely connected computer, PeakTrak displays a window so you can 
select the method file. After selecting the file, click the Open button to save the method file on 
the module’s internal hard drive.

5.2.1.10  Export Method
Choose this command to save a Method file in a location other than the module’s internal 
hard drive. This can be done to archive method files or to transfer the method to another 
module using the IMPORT METHOD menu command. From the touch screen, this command 
opens the FILES window so you can save the file on a USB Flash storage device. When 
selecting this command from a remote computer, PeakTrak displays a window from which 
you can save the method file. 

5.2.1.11  Export SMM/XL Method
Choose this command to export a method file for use on a different CombiFlash Companion 
system equipped with the Solvent Management Module (SMM) or a CombiFlash Companion 
XL system. From the touch screen, this command opens the FILES window so you can save the 
file on a USB Flash storage device. When selecting this command from a remote computer, 
PeakTrak displays a window from which you can save the method file.

5.2.1.12  Print
From the touch screen, this command prints the completed run on the network printer (see 
NETWORK PRINTING on the NETWORK CONFIGURATION window). When selecting this 
command from a remotely connected computer, PeakTrak displays the Printer dialog. From 
this dialog window, you can select and configure the printer of your choice. After configuring 
the settings, click the PRINT button to print the completed run.

5.2.1.13  Logout
Choose this command to logout of the module. After logging out, the module displays a login 
screen and waits for the next user to log in.

5.2.2  Method Editor
Selecting the Method Editor menu command will open the METHOD EDITOR window. Use this 
window to view and modify the advanced method file settings.

5.2.3  Tools
PeakTrak’s Tools menu has the following options:
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5.2.3.1  Auto Prime/Valve Wash
Choose this command to automatically prime the solvent pumps and wash the injection valve. 
When you select this command, the module will display the AUTO PRIME/VALVE WASH window.

Figure 5-2  Tools Menu

5.2.3.2  Fraction Valve Wash
Choose this command to pump solvent or air through the optional Fractionation Valve. When 
you select this command, the module will display the FRACTION VALVE WASH window.

5.2.3.3  Manual Control
Choose this command to open the MANUAL CONTROL window. From this window you can 
operate the module manually. Manual control can assist with priming or purging the internal 
plumbing, and aid module troubleshooting.

5.2.3.4  Auto Zero
Choose this command to zero the absorbency trace during a run.

5.2.3.5  Edit defaults
Choose this command to open the METHOD EDITOR window from which you can modify the 
default method files. To prevent tampering with the default column programs, access to this 
function can be password protected using the SET PASSWORD menu command.

See Also: EDITING A DEFAULT METHOD.

5.2.3.6  Configuration
Choose this command to open the CONFIGURATION window. From this window you specify the 
solvents used with the module, set default volumes for collection tubes, set the module date and 
time, configure network settings, etc.

5.2.3.7  Set Password
Choose this command to open the SET PASSWORD window.

The password protects unauthorized modifications to:

• Default methods

• User management

• Module date and time
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• Module password

Before any of the above can be accessed, the user must enter a password. Password protection 
for the default methods can be disabled so all users may modify default methods.

5.2.3.8  User Management
Choose this command to open the USER MANAGEMENT window. Use this window to add or 
remove users from the module. This feature allows you to create a working folder on the 
module for each user. Use the FILE>SET DATA PATH command to select your folder.

To prevent unauthorized changes to user management, this function is password protected.

Figure 5-9  User Management Screen

Figure 5-10  User Management Summary Screen

To prevent unauthorized changes to user management, this function is password protected.

5.2.3.9  Calibrate Touchscreen
Choose this command from the touch screen to calibrate the interaction between touch screen 
display elements and stylus location.

The calibration routine places a series of targets on the touch screen display. Touch the exact 
center of each target with a stylus. The routine will move clockwise through 20 calibration 
targets, after which the module will return to the normal display.

During calibration routine, ensure that no part of your hand or anything other than the 
stylus touches the screen.
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 N ot Note

f you select this command from a remote connection, the module will start the calibration routine. 
Invoking this from a remote connection may be useful if the module is mis-calibrated to a degree 
that this menu command cannot be selected from the touch screen

5.2.4  Help
PeakTrak’s Help menu has the following options:

Figure 5-10  Help Screen

5.2.4.1  Help
Choose this command to view the Help documentation.

5.2.4.2  Service
Qualified service personnel use this command to access the module’s service functions. These 
service functions are password protected to restrict their use to trained personnel.

5.2.4.3  Software Update
Choose this command to open a window used to install patch files to update your CombiFlash 
Torrent Module software.

5.2.4.4  Export Log Files
During operation, the module writes operating data to a log file. Teledyne ISCO service 
personnel can interpret this data to optimize module performance or to troubleshoot 
difficulties. Teledyne ISCO recommends that you use this menu command only when advised 
by a qualified service technician.

5.2.4.5  About PeakTrak
Choose this command to view information about PeakTrak.

5.2.4.6  About ISCO
Choose this command to view contact information for Teledyne ISCO.
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5.3  PeakTrak Windows
This section contains descriptions of the windows used for most PeakTrak tasks. In this 
section you will find information on the following:

• MAIN WINDOW

• METHOD EDITOR

• THIS FEATURE ALLOWS USER TO SET SAMPLE LOADING PARAMETERS TO BE SAVED WITH THE METHOD. SEE 
SECTION 4.4.3 FOR MORE DETAILS.

• COLUMN DATA

• FILES

• SET DATA PATH

• AUTO PRIME/VALVE WASH

• MANUAL CONTROL

• CONFIGURATION

• SET PASSWORD

• USER MANAGEMENT

5.3.1  Main Window
The Main window gives you control of frequently used functions before and during the run. 
After a run, or when viewing previous runs, the Main window displays peak collection data as 
well as the settings used for that run. The Main window dynamically changes to display the 
controls required for the current state of the module.

The top region of the Main window always displays a GRADIENT PLOT area. The bottom region 
of the window displays the RUN SETTINGS, RUN CONTROL BUTTONS, and PEAK COLLECTION 
BUTTONS. After a run, the left side of the window changes to show a collection point map or 
the method parameters in a PEAK COLLECTION DATA pane.

5.3.1.1  Gradient Plot
The gradient plot area depicts the current gradient that will be used for the run. The X-axis 
of the plot displays the run time in minutes or COLUMN DATA. The X-axis scale can be 
adjusted by typing or selecting the Run Length. The left Y-axis displays absorbance units and 
the right Y-axis indicates the percentage of solvent B. By default, PeakTrak automatically 
scales the left Y-axis to best display the absorbance trace. PeakTrak also sets the right Y-axis 
to 100%. You can override the Y-axes scales by clicking the Format Graph button and setting 
the desired values.

The Cartridge Bypass button may be used during a run to relieve backpressure caused by 
impurities precipitating in the solid load cartridge. Use this feature with care to avoid leaving 
desired compound on the cartridge. Read more about this feature in BYPASSING THE SOLID 
LOAD CARTRIDGE

If the external detector option is enabled, the plot area will include a secondary left Y-axis to 
display the analog input trace. 

The gradient plot area also provides a convenient method to edit the gradient curve. You can 
click and drag any of the points to change the shape of the curve and use the buttons at the 
bottom of the plot area to insert and delete points. For complete instructions on defining 
gradient curves, see DEFINING A GRADIENT.



CombiFlash Torrent® User Manual

5-10

EAR99 Technology Subject to Restrictions Contained on the Cover Page

5.3.1.2  Run Settings

• RediSep — PeakTrak reports the detected RediSep column media and size. The column 
should match the one that will be used for the run. You may override the detected column 
size by selecting a different size or media. 

• Sample Name — The sample name is a text entry box in which you can label the run. 
Type a unique descriptor. PeakTrak saves the run information under this name. 
Therefore, PeakTrak cannot accept any characters that are reserved by the operating 
system (* ? / \, etc.). If you do not type a Sample Name, PeakTrak will generate a date/time 
stamp for the name when you click the Play button to begin the run.

• Flow Rate — Type or select the desired flow rate for the run. When using the ISCO 
default column methods, PeakTrak sets the flow rate to the optimum flow rate of the 
column.

• Detector — Reports the current peak detection mode. To change the peak detection 
settings, open the METHOD EDITOR window. 

• Solvent A — Select the desired solvent from the list. The solvents in the list are those 
defined by the CONFIGURATION window. 

• Solvent B — Select the desired solvent from the list.

5.3.1.3  Run Control Buttons
From left to right, the control buttons are:

• Play — The Play button starts or resumes the run. After a run has started, this button is 
replaced by the Pause button.

• Pause — The Pause button holds the %B at the current value while the module continues 
to operate (sometimes called an isocratic hold). Note that pausing the run extends the run 
length. While in the Paused state, you can resume the run by clicking the Play button, or 
stop the run by clicking the Stop button. If you resume the run, the module continues the 
gradient curve from the %B when the module was paused.

• Stop — This button suspends the entire run. Unlike the Paused state, the pump, peak 
detection, and fraction collection will not operate. While stopped, you can save the run 
data by clicking the Save button, abort the run by clicking the Rewind button, or resume 
the run by clicking the Play button.

• Next Tube — This button advances the fraction collector to the next tube position. This 
allows you to conveniently collect elute of interest in new tube.

• Rewind — This button is active when the module has completed the run, or if the run was 
Stopped by clicking the stop button. The Rewind button returns you to the MAIN WINDOW.

• If you have stopped the run before its programmed run length has elapsed, the current 
method is modified using the new run length. This modified method is ready for the next 
run, or can be saved for future runs.

• Fast Forward — Click this button to jump to the next step of a run. 

Once you’ve started a run, the module performs several steps. The first step is to deliver 
solvents using the programmed gradient for the entire run length. When this step is complete, 
the module will purge the column with air. Following this, the module will clean the injection 
valve.
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Clicking the Fast Forward button will cause the module to skip any remaining time in the 
current step and advance to the beginning of the next step. Unlike the Rewind button, the 
Fast Forward button will not modify the current method’s run length setting.

5.3.1.4  Peak Collection Buttons
When using an optional fraction collector or fractionation valve, Peak Collection buttons are 
located at the bottom of the Main window.

• All — Click this button to collect all fluids in the fraction collection tubes.

• Peaks — Click this button to collect only eluted peaks in the fraction collection tubes.

• None — Click this button to divert all fluids to the waste port.

When an optional fraction collector or fractionation valve is not connected to the system, peak 
isolation is still possible. By selecting the Manual option, the module will suspend the run 
when it detects a peak. While suspended, you can manually direct the elute to an appropriate 
collection vessel. After redirecting the elute, click OK to continue the run. This action is 
repeated at the beginning and end of each peak.

5.3.1.5  Peak Collection Data
Peak Collection data is displayed in the Main window after a run. You may also open a RUN 
FILE for viewing data from previous runs.

The peak collection data is displayed on the left side of the Main window:

• Rack and tube information — Collected peaks are color coded in the rack diagram so 
that you can easily locate the peaks of interest. The tube colors correspond to the color 
bars under the peaks displayed on the chromatogram. If during the run more than one 
set of tube racks was filled, use the Next and Previous Rack buttons to view the 
additional racks. The table below the rack diagram displays the peak data in tabular 
form. When using the Fractionation Valve option, the diagram corresponds to the valve 
positions. The collection containers at these positions are considered a rack. If the run 
uses more than one rack, use the next and previous rack buttons to view the information 
for each rack. 

• Display Method — Click the Display Method button to view a summary of the peak 
detection and collection settings for the run. You can return to the rack and tube display 
by clicking the Display Rack button.

See Also:

• PEAKTRAK OVERVIEW

• EDITING A METHOD

• REAL-TIME GRADIENT EDITING

• METHOD EDITOR for advanced functions

5.3.2  Method Editor
The Method Editor window has several sections. 
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Figure 5-6  Method Editor Screen

The BUTTON BAR at the top of this window gives you quick access to file operations, a THIS 
FEATURE ALLOWS USER TO SET SAMPLE LOADING PARAMETERS TO BE SAVED WITH THE METHOD. 
SEE SECTION 4.4.3 FOR MORE DETAILS., and COLUMN DATA. Below the button bar are the RUN 
SETTINGS and the RUN NOTES. The lower part of the window contains the GRADIENT PLOT AREA 
and settings for PEAK COLLECTION and PEAK DETECTION.

5.3.2.1  Button bar
The Method Editor button bar contains the following:

• New — Click this button to open a new method file using the default method settings for 
the detected column media and size.

• Open — Click this button to open a method file stored on the module’s internal hard 
drive.

• Save — Click this button to save any modifications to the current method file. Note that if 
you attempt to save modifications to a default method file, the FILES window will open 
instead so you can rename the file. This preserves the default method. If you do wish to 
edit and save PeakTrak’s default methods, use the “TOOLS>EDIT DEFAULTS” command 
instead.

• Save As — Click this button to open the FILES window. From this window you can rename 
the current method and save it on the module’s internal storage.

• Exit — Click this button to close the Method Editor and return to the MAIN WINDOW.

• Gradient Optimizer — Click this button to open the THIS FEATURE ALLOWS USER TO SET 
SAMPLE LOADING PARAMETERS TO BE SAVED WITH THE METHOD. SEE SECTION 4.4.3 FOR 
MORE DETAILS. window. This feature produces an optimized gradient based on your TLC 
retention factor data.

• Column Data — Click this button to open the COLUMN DATA window. This window 
reports information about the column installed in the module.

• Time to CV / CV to Time — Click this button to toggle the Run Length (X-axis) units 
between minutes and COLUMN DATA. You can configure PeakTrak’s default Run Length 
units by changing the CONFIGURATION settings.
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5.3.2.2  Run Settings

• RediSep Column — The RediSep column media and size are detected by PeakTrak and 
reported here. The column should match the one that will be used for the run. You may 
override the detected column size by selecting a different size. 

• Sample Name — The sample name is a text entry box in which you can label the run. 
Type a unique descriptor. PeakTrak saves the run information under this name. 
Therefore, PeakTrak cannot accept any characters that are reserved by the operating 
system (* ? / \, etc.). If you do not type a Sample Name, PeakTrak will generate a 
date/time stamp for the name when you click the Play button to begin the run.

• Flow Rate — Type or select the desired flow rate for the run. When using the ISCO 
default column methods, the module sets the flow rate to the optimum flow rate of the 
column.

• Equilibration Volume — Type or select the volume of solvent that is pumped through 
the column and out the waste port before the sample is introduced. Data is not collected 
while this volume is being pumped. Three or more column volumes are recommended for 
most applications.

• Initial Waste & Time Windows — Click this button to open a window from which you 
can view and modify these settings. For the Initial Waste, type or select the volume of 
eluate that is allowed to pass through the column to the waste port after the sample is 
injected. After this volume has been diverted, the module is ready to collect peak or all 
fluids in the collection tubes. Use this feature to clear the internal lines of any elute left 
from a previous run and to conserve collection tubes by diverting all fluids until the first 
peak is expected.

• Time Windows can limit the fraction collection to specific time durations of the run. To 
use time windows, first enter a start time and an end time. Note that all times are 
relative to start of the run, just following the sample injection. Then choose a peak 
collection mode. If you select Peaks the module will collect fluid only when the time 
window is active and a peak is present. If you select All the module will collect all fluid 
during the time window regardless of the peak state. Define up to six time windows.

• Air Purge — Type or select the duration of a post-run air purge, in minutes. An air 
purge clears the solvent from the column and the fluid path, forcing any liquid out the 
waste port. If you are disposing the column after each run, a sufficient post-run air purge 
ensures that it will be empty. To disable the air purge, enter a value of 0 (zero). A column 
can also be manually air purged. See MANUAL CONTROL.

5.3.2.3  Run Notes
Use this text entry box to enter comments or notes for the run. These comments will be saved 
with the run and will appear in TXT and PDF reports. 

5.3.2.4  Gradient Plot Area
The gradient plot area depicts the current gradient profile that will be used for the run. The 
X-axis of the plot displays the run time in minutes or COLUMN DATA. The X-axis scale can be 
adjusted by typing or selecting the Run Length. The left Y-axis displays absorbency units and 
the right Y-axis indicates the percentage of solvent B.

The gradient plot area also provides a convenient method to edit the gradient curve. You can 
click and drag any of the points to change the shape of the curve, or use the buttons at the 
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bottom of the plot area to insert and delete points. The following controls appear in the 
Gradient Plot Area:

• Insert — Click this button to enable the gradient point insert mode. When this mode is 
active, click the gradient curve to add a single point. You can then drag the new point to 
any desired position. Click the insert button once for each gradient point that must be 
added to the plot area.

• Delete —Click this button to enable the gradient point delete mode. When this mode is 
active, PeakTrak will delete the point nearest the next click on the gradient curve. Click 
the Delete button once for each point that must be deleted from the plot area.

• Run Length — Type or select the length of the run. Note that this will change the scale of 
the X-axis on the gradient. Points that define the gradient will be automatically scaled to 
fit the new run length. The run length can be expressed in minutes or COLUMN DATA (CV). 
You can configure PeakTrak’s default Run Length units by changing the CONFIGURATION 
settings.

• Solvent A — Select the desired solvent from the list. The available solvents are those 
defined by the CONFIGURATION settings.

• Solvent B — Select the desired solvent from the list. You can program mid-run solvent B 
changes by clicking the Edit Gradient button to open the GRADIENT TABLE.

• Edit Gradient — Although the gradient may be edited directly within the plot area, you 
can also edit the gradient in tabular form. Click this button to open the GRADIENT TABLE.

For complete instructions on defining gradient curves, see DEFINING A GRADIENT.

Gradient Table The gradient table depicts the points that define the gradient curve in a tabular 
format. From this table you can change the duration and %B concentration of any point on the 
curve. To do so, select new values for the gradient points. Changes that you make to the table 
will be reflected in the gradient plot area.

You can also change the number of points on the curve by inserting or deleting rows in the 
table. To change the number of points, first highlight a table cell or row. Then click the 
appropriate Gradient Button for the action you desire.

• Insert Point — This command or button will insert a row below the selected point. 

• Delete Point — This command will delete the selected row. Note that you cannot delete 
the initial point.

PeakTrak automatically updates the Run Length setting or scales the other points when you 
change the number of points and their duration on the curve.

To close the Gradient Table, click the Edit Gradient button.

See Also: DEFINING A GRADIENT

5.3.2.5  Peak Collection
Use the Peak Collection buttons to set the collection mode. 

• All — Click this button to collect all fluids during a run. 

• Peaks — Click this button to collect only eluted peaks during a run. 

• None — Click this button to divert all fluids to the waste port during a run.
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• Tube Volume — You can also specify the Tube Volume for collected fluids. This 
volume can be the default maximum volume (Max option) as entered in the 
CONFIGURATION window, or a method-specific volume less than the capacity defined 
by the CONFIGURATION window. When using a Foxy fraction collector or the 
Fractionation Valve, note that the actual fraction size may be less if a newly detected 
peak causes a tube change, or if you click the Next Tube button.

• Peak — Type or select the desired volume to be collected in each tube when the 
module detects a peak.

• Non-peak — Type or select the desired volume to be collected in each tube when 
peaks are not detected. This setting allows you to conserve tubes without diverting 
non-peak elute to waste. This setting is ignored when the peak collection mode is set 
to Peaks or None.

5.3.2.6  Peak Detection
This section of the window contains option buttons to enable and disable various peak 
detection options. When an option is enabled, the window also allows you to modify the 
setting details for that peak detection option. All enabled options will be displayed on the 
chromatogram. 

 N ot Note

You can select up to two peak detection options (excluding the External option). If using two 
options, such as 1 with 2, PeakTrak considers a peak to be present when either option is true (a 
logical OR).

• 1 and 2 (wavelength 1 and 2) — Enable these options to use and configure 
primary and secondary wavelength detection. When enabled, type or select the peak 
detection wavelength in nanometers, then click the Details button to configure 
additional settings described below.

• Slope Based — Select this option to enable Slope-based peak detection. When 
enabled, peaks will be recorded if the slope algorithm indicates a peak within the 
Peak Width setting.

• Peak Width — Select the average peak width setting. Peak widths are measured at 
the baseline. The slope detector will detect peak widths ranging from about 0.2 to 2 
times the peak width setting. For example, if you entered a peak width of 1 minute, 
the range would be 12 seconds to 2 minutes. For best operation, the peak width should 
be set to just over the average peak width being separated. For instance, if the 
average peak width is 45 seconds, you should enter a peak width of 1 minute. For most 
flash chromatography, 1 minute is a good starting point for a peak width.

• Threshold Detection — Select this option to enable Threshold peak detection. 
When enabled, peaks will be recorded if the Absorbance Units (AU) value is exceeded.

• Threshold — Type or select the Absorbance Units value to be used for Threshold 
detection.

• Note: If both Slope and Threshold peak detection methods are checked, PeakTrak 
considers a peak to be present when any one condition is met. This logical OR 
operator means that PeakTrak will cut a peak when either the Slope condition is true, 
or when the Threshold condition is true.
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• All Wavelength Detection — Enable this option to detect peaks within a user-selected 
range of wavelengths. When enabled, click the Details button to configure additional 
settings. These settings include the slope-based and peak width options described in 1 
and 2 above. Additionally, you can type or select the minimum and maximum 
wavelengths limits in nanometers.

• External Detector — Enable this option to use a 0 to 1 volt analog signal from an 
external detector. When enabled, click the Details button to configure additional settings. 
These settings include the slope-based and peak width options described in 1 and 2 
above. PeakTrak will use its internal algorithms to detect and cut peaks based on the 
analog input signal. Refer to the External Detector instruction sheet for electrical and 
plumbing requirements.

• Show Ratio — If using two of the above peak detection options, check this option to 
display a ratio of the selected wavelengths. The ratio trace is often a useful indicator of 
purity. Refer to the MONITORING THE WAVELENGTH RATIO topic for more details on this 
feature.

5.3.3  Sample Loading
This feature allows user to set Sample Loading parameters to be saved with the method. See Section 
4.4.3 for more details.

5.3.4  Gradient Optimizer
Use this window to automatically generate a gradient curve from the results of two TLC plates. 
Follow the on-screen instructions, then enter valid TLC data in the Gradient Optimizer 
window. Click the OK button and the Method Editor window will display the new gradient 
curve. 

When using the Gradient Optimizer, PeakTrak may insert an isocratic hold into the generated 
gradient. Furthermore, PeakTrak may automatically extend the isocratic hold during the run 
to increase peak resolution.

To open the Gradient Optimizer window, open the METHOD EDITOR window, then click the 
Gradient Optimizer button.

5.3.5  Column Data
The Column Data window reports information about the RediSep Rf column installed in the 
module. Compatible RediSep Rf and RediSep Rf Gold columns have an RFID tag that identifies 
the column type. PeakTrak reads this information to identify the size and media, then 
automatically loads a default method for the inserted column.

If the column is reusable, the module will also write information to the RFID tag that can help 
you manage the column’s use. The “Number of times used,” “First used on,” and “Last used on” 
information can help you determine when the column should be replaced. The “Last fluid used” 
will help you determine if any solvent remaining in the column will be miscible with the solvent 
currently used in the module.

To view the Column Data window, open the METHOD EDITOR window, then click the Column 
Data button.
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5.3.6  Files
The Files window is adaptive. That is, its function and features change according to the 
command used to open the window. Menu commands such as FILE>OPEN and SAVE METHOD 
AS, or clicking Open and Save As buttons will open this window. Use this window to browse 
the module’s files and folders. The following controls appear on the window:

• Current Path — The top-left corner of the window displays the path (current folder). As 
you browse through the files, the path will update as you go. You can click the folder 
names to return to upper folder levels.

• File and Folder Operation buttons:

• Copy — Click this button to copy a highlighted file to the module’s clipboard memory.

• Paste — Click this button to paste a file from the clipboard memory. If the file already 
exists in the current folder, the module will ignore the Paste command to prevent the 
original file from being overwritten.

• Delete — Click this button to delete a highlighted file or a folder and its contents.

• New Folder — Click this button to create and name a new folder.

• Up — Click this button to browse the contents of the next-higher folder level.

• File/folder info scroll box — This box lists the contents of the current folder. The 
contents can be sorted by clicking the column headings. 

• File Type — This option is shown when you can limit the display to certain types of 
files. Select the desired file type from the list.

• File Name — This text entry box is used to identify the currently selected 
(highlighted) file or folder when browsing and opening files. When using a Save As 
command, use this box to name the file. 

• Open/Save — This button performs the listed action.

• Continue Last Run on Detected Column — This option appears when using the 
FILE>OPEN command. If you click this option, the module reads the RFID tag on the 
RediSep Rf column, loads the previous method and adds a run extension. You can then 
modify the method and click Play to continue the run, skipping the equilibration and 
injection. This feature can be useful if the run was interrupted or if additional 
compounds of interest might be left on the column.

• Load Previous Run from Detected Rack — This option appears when using the 
FILE>Open command. If you click this option, PeakTrak reads the RFID tag on a 
single Foxy fraction collector rack and displays the RUN FILE. This feature is useful 
when there is a need to recall run results at a later time.

• Cancel — Click the Cancel button to close the window without saving or opening the 
file.

5.3.7  Set Data Path
The FILE>SET DATA PATH menu command opens the Set Data Path window. Use this window 
to select a default folder for the current user. After selecting a folder, file operations such as 
saving or opening files will use this selected directory.
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The Set Data Path primarily is used with the USER MANAGEMENT feature. User Management 
will automatically create a folder for each user. When using the module, set the data path to 
your folder or a subfolder within. Each user has a different data path.

The window contains the following controls:

• Current Data Path — The top-left corner of the window displays the path (current 
folder). As you browse through the files, the path will update as you go.

• New — Click this button to add and name a subfolder within the currently selected folder.

• Delete — Click this button to delete the selected folder.

• Folder selection box — This box lists the available folders and selection buttons. 

• OK — Click this button to save your selection as the data path and close the window.

• Cancel — Click the Cancel button to close the window without changing the data path.

5.3.8  Auto Prime/Valve Wash
The Auto Prime feature is a convenient way to prime the pumps with solvent. This should be 
done whenever new solvents are connected to the back panel ports. An Auto Prime pumps 200 
mL of the selected Solvent B, drawing it in through the inlet port, through the pump and 
injection valve, and out the waste port. The Auto Prime then does the same for Solvent A. By 
priming Solvent A last, the module is ready for the starting mobile phase of the next run.

• The Auto Prime window is opened by selecting the TOOLS>AUTO PRIME/VALVE WASH menu 
command. The window contains the following controls:

• Progress bar — This bar displays how much of the solvent has been pumped. 

• Play button — Click this button to start the Auto Prime.

• Fast Forward button — Click this button to skip to the next Auto Prime step.

• Cancel button — Click this button to stop the Auto Prime and close the window.

5.3.9  Fraction Valve Wash 
The Fraction Valve Wash feature is a convenient way to wash the optional Fractionation Valve 
with solvent and air. This should be done whenever new solvents are connected to the back 
panel ports, or as needed. From the window, you can select Solvent A, Solvent B, and Air. If 
more than one option is selected, the wash is performed sequentially (Solvent B, then Solvent 
A, then Air). 

The Fraction Valve Wash window is opened by selecting the TOOLS>FRACTION VALVE WASH 
menu command. The window contains the following controls:

• Option buttons — Choose one or more as needed. 

• Play button — Click this button to start the pumping sequence.

• Stop button — Click this button to stop Fraction Valve Wash.

• Close button — Click this button to stop the Fraction Valve Wash and close the window.

5.3.10  Manual Control
Manual Control can assist with method development, maintenance of the module plumbing, 
and system troubleshooting. The Manual Control window can be opened by selecting 
TOOLS>MANUAL CONTROL from the PeakTrak menu.
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The Manual Control Window has several controls:

• Percentage Solvent B – type or select the mixture percentage.

• Flow Rate – Type or select the pump’s flow rate in mL/min.

• Pump into Tube # – As a default setting, solvent is pumped to the waste port during 
manual control. If you would like to collect the solvent in a tube, select the option button 
and enter the Foxy fraction collector tube number or Fractionation Valve position. This 
feature can be useful when trying to recover a compound that has precipitated or 
“crashed” somewhere in the fluid path.

• Valve Position – Select the CombiFlash Torrent valve position for the desired solvent 
flow path. 

• Prime A – Click the “Prime A” button to pump 100% of solvent A at the selected flow 
rate.

• Prime B – Click the “Prime B” button to pump 100% of solvent B at the selected flow 
rate.

• Prime X% B – Click this button to pump a mix of Solvent A and B, according to the 
Percentage Solvent B value.

• Air Purge Cartridge – Click this button to pump compressed air or external gas 
through the solid sample cartridge.

• Air Purge Column – Click this button to pump compressed air or external gas through 
the column.

• Stop – Click this button to stop the pump. This button is only active while the pump is 
running. 

The right half of the window contains a lamp energy window to indicate if the flow cell 
windows are dirty. An indicator graphically shows the current level along with a numerical 
value within the graph area. Any value in the mid-range of the graph is normal. 

 N ot Note

The pressure limit during manual control is 100 psi.

Click the Close Manual Control button to close the window.

See Also: MANUAL CONTROL OF THE COMBIFLASH TORRENT MODULE

5.3.11  Configuration
The Configuration window allows you to define the operating characteristics of your 
CombiFlash Torrent module. It also allows you to configure the module for network 
connections for remote access and printing. Open the Configuration window by selecting the 
TOOLS>MANUAL CONTROL menu command.

The configuration window displays four tabs: INSTRUMENT CONFIGURATION, NETWORK 
CONFIGURATION, and USER PREFERENCES, FRACTION COLLECTOR.
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5.3.11.1  Instrument Configuration

Solvent Controls

• Add Solvent — Click this button to enter a solvent name. PeakTrak can store up to 16 
solvent names. 

• Remove Solvent — Click this button to open a list of all entered solvent names. Select 
the names you want to remove and then click the OK button.

• Enable Solvent Level Sensing — If this option is selected, the module will check the 
solvent levels before and during a run. PeakTrak will alert you if a solvent level becomes 
too low. Note that the solvent level monitoring option does not control the operation of 
Waste Solvent Level monitoring. Waste level sensing is always enabled at the beginning of 
a run.

• Minimum Solvent Level — This value is density-dependent, thus a range is given. To 
understand the range, consider that dichloromethane is more dense than hexane. If the 
selected range is 1–4, an alert would be triggered when the dichloromethane falls to about 
1 cm above the bottom of the weighted filter. At the same selected range, an alert would be 
triggered when the hexane solvent level falls to about 4 cm above the weighted filter.

• Waste Level Sensing — The module can detect full container conditions if the air line is 
placed in the waste collection container. If waste level detection is desired enable the 
waste level sensing feature (recommended). Otherwise, uncheck this option to disable this 
feature.

• B Priming Pump (Torrent Only) — The B prime port is for outflow from the B prime 
pump on the Torrent to ensure the B pump maintains prime at low % of B solvent 
conditions (like during equilibration). If on a system without a Solvent Selection Valve it is 
part of the plumbing of the B solvent line. The B Prime Pump can be enabled or disabled 
in the Configuration screen.

If using a Solvent Selection Valve (SSV) on a Torrent system, the user has a couple options 
on plumbing the B Prime Port.

If performing methods with equilibration below %B, in order to maintain B pump prime 
the B prime line can be plumbed to go to the waste container. his prevents contamination 
of the B Solvent with sample or other B solvents. The pump is then enabled in the 
Instrument Configuration screen. Note: A small amount of sample could be lost to waste 
via the B Prime Port, so an separate waste vessel may be desired.

For methods with equilibration or starting %B above 5%, the B Prime Port can be plugged 
with Cap 209-0165-21, in accessory kit 60-5249-002. The B Prime pump can then be 
disabled in the Instrument Configuration screen. Note: The B Prime pump is not on the 
Torrent AQ system. 

CombiFlash Torrent Name Enter a name for the module. This name will appear in the title bar of 
the Main window. The name will also appear in run summaries. Unique names are helpful 
when operating more than one CombiFlash Torrent module in your lab.

Time Zone Select your local time zone.
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Set Date/Time Click this button to set the date and time. From the touch screen, this command 
opens a window that allows you to set the instrument date and time. If you select this 
command from a remotely connected computer, this menu command automatically sets the 
module time to match the computer’s.

 N ot Note

The module will restart after you set the time. 

To prevent unauthorized time changes, this feature is password protected. See also: SET 
PASSWORD.

Vapor Limit Type or select the vapor limit setting. The CombiFlash Torrent module’s internal 
vapor sensor detects vapors present in the module. When this value is exceeded, the module 
will shut down to avoid a hazardous condition. For more information, refer to SETTING THE 
VAPOR LIMIT.

Set Default Tube Volume Click this button to open a window from which you can set the default 
volume of the collection tubes. You can increase or decrease these values to set the desired 
default volume collected in each container. Ensure that you do not enter a value that exceeds 
the container’s capacity. This will overfill the container. 

The Foxy fraction collector will automatically advance to the next tube when this default 
volume is met in each tube. Keep in mind that the PEAK COLLECTION settings on the METHOD 
EDITOR window may override this default volume. During a run, other factors such as 
automatic tube advances for detected peaks will affect collected volume.

Enable Automatic Column Purchase This feature requires a current subscription in a Teledyne 
ISCO Column Plan. Contact your sales representative for more information on this feature. 
The certificate issued with the column plan includes instructions for activating this feature.

5.3.11.2  Network Configuration
Network configurations settings require assistance from your network administrator. Contact 
your Information Technology department before changing the settings.

Instrument IP Address Configuration:

Use these settings to specify the instrument’s network address and its parameters:

• Network Type — Select the “Static IP” option. 

• This option will require an IP Address, Netmask, and Gateway provided by your 
network administrator.

• IP Address — Enter the static IP Address for the module.

• Note: The module also provides limited support for DCHP connections. If DHCP is 
desired, select DCHP as the network type and follow the displayed instructions to 
complete the connection.

• Netmask — Enter the Netmask for the module.

• Gateway — Enter the Gateway for the module.

Network Printing The module can print to a network printer and supports JetDirect and line 
printer (LPR) queues.
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Consult with your network administrator to determine the IP address of selected printer. If the 
printer uses an LPR print queue, you must also find out the queue name. If the printer uses a 
JetDirect print queue, also ask for the port number. When this information is known, you can 
proceed with configuring module for network printing.

Follow the on-screen instructions for entering the address and queue information. After 
successfully printing a test page, the network printer will be available for printing using the 
FILE>PRINT menu command and the AUTOMATICALLY PRINT REPORT AT END OF RUN feature. 

The Network printing controls may also be configured to print to a local USB printer connected 
the system’s back panel USB port. The printer must support postscript printing. To configure 
the local printer, select Postscript for the Printer Type. Then, type the following connection 
URL: “usb:/dev/usb/lp0”.

Network File Save Configuration When configured, this feature allows the module to access a 
network directory from which it can save run files as PDF, text, or run monitor. To enable this 
feature, select a file type to be saved and enter the remaining settings necessary for network 
access. Your network administrator will be able to provide the required settings. 

NOTE: All server and domain names must be fully qualified. That is, entries must include the 
full name (server name.domain.domain…). Use forward slashes (/), not back slashes, when 
entering the network share path. 

5.3.11.3  User Preferences

Language Select the language for PeakTrak.

Automatically Print Report at End of Run If this option is enabled, the module will print a completed 
run report using the NETWORK PRINTING feature. 

Beeper If enabled, the Torrent module will sound an alert whenever user intervention is 
required during a run.

Default Run Units Run units are displayed along the X-axis of the chromatogram. Select “Time, 
Minutes” or COLUMN DATA (CV) run units to be displayed on program settings and 
chromatogram displays. 

Enable Run Length Extension When enabled, this option automatically extends the run if a peak is 
eluting at the end of the programmed run length. This ensures that a late-eluting peak is still 
collected.

Gradient Method Select the desired gradient method option.

• If the Linear method is selected, solvents A and B will be mixed gradually from the last 
programmed %B until the next programmed %B is reached. This method connects the 
inflection points that define the gradient with a straight line.

• If the Step method is selected, each %B value is held until the next programmed %B is 
reached. Because the %B values are held, the changes at each new value are nearly 
instantaneous, producing a stepped appearance on the plot area.

• If Isocratic is selected, the module will pump a single %B mix throughout the run.
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Enable Rapid Equilibration Select this option to turn on rapid equilibration. When enabled, this 
time-saving feature pumps solvent at the maximum flow rate during column equilibration. 
Note that some column sizes and types might be adversely affected by high flow rates.

5.3.11.4  Fraction Collector
Use this tab to configure the CombiFlash Torrent module to control up to four Foxy R2 High 
Flow fraction collectors. This tab is also used to configure the module for use with a 
Fractionation Valve. 

Foxy fraction collector(s) should be connected to the module via an Ethernet cable. To 
communicate with each fraction collector, the IP address settings on this tab must match the 
IP address set in each fraction collector. Note that all IP addresses must be unique.

 N ot Note

The optional Foxy R2 High Flow fraction collector does not support DHCP. If you are adding the 
Torrent module with optional Foxy R2 High Flow fraction collectors to your organization’s network, 
a static IP address must be assigned to each fraction collector. Contact your IT department for 
assistance.

A delay volume must also be specified for each Foxy fraction collector connected as a system. 
If using the Fractionation Valve instead, a delay volume should also be entered. The delay 
volume entries ensure that the tube changes occur when the peak fluids are present at the 
fraction collector diverter valve. 

If using the tubing provided with the Foxy R2 High Flow fraction collectors or Fractionation 
Valve, enter the following as applicable: 

• Foxy 1 Delay Volume - 20 mL

• Foxy 2 Delay Volume - 40 mL

• Foxy 3 Delay Volume - 60 mL

• Foxy 4 Delay Volume - 80 mL

• Fractionation Valve Delay Volume - 10 mL

If using custom-length tubing, calculate the delay volume use the formula:

V = pi / 4 x D2 x L 
(otherwise expressed as: V= 0.7854 x D2 x L), 

where L is the tubing length (cm) and D is the inside diameter (cm). The resulting volume is 
in milliliters.

Fractionation Valve Configuration If using the Fractionation Valve, enable the Fractionation Valve 
option and enter a delay volume. The delay volume entries ensure that the tube changes 
occur when the peak fluids are present at the fraction collector diverter valve. You can 
calculate the delay volume using the formula in the Fraction Collector topic. 

5.3.12  Set Password
This window, opened by selecting the TOOLS>SET PASSWORD menu command, is used to enter 
and change the module password, and to enable password protection for the default methods.

To enter or change a password:
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1.Type the password.

2.Type the password again to verify your entry.

3.To protect the Default methods select the “Require Password For Editing Default Methods” 
option.

4.Click the OK button to save your settings and close the window.

The following menu commands will require a password before displaying the requested 
window:

• TOOLS>EDIT DEFAULTS 

• TOOLS>USER MANAGEMENT 

• HELP>SERVICE 

• TOOLS>SET PASSWORD. This protects the current password.

5.3.13  User Management
Use the TOOLS>USER MANAGEMENT menu command to open a window from which you can add 
and remove module users. When you add a user, PeakTrak will create a user folder that 
becomes the data path for that user. User management, in conjunction with this data path 
feature, conveniently lets you store your working files apart from other module users.

To add a user, click the Add New button and enter the user name. To delete a user, click the 
Delete button next to the user’s name and confirm the action.

See also: SET DATA PATH

5.4  Examples of PeakTrak actions
In this section you will find instructions for typical PeakTrak tasks, such as:

• EDITING A METHOD

• ALTERNATIVE WAYS TO CREATE METHOD FILES

• EDITING A DEFAULT METHOD

• DEFINING A GRADIENT

• REAL-TIME GRADIENT EDITING

• MONITORING THE WAVELENGTH RATIO

• BYPASSING THE SOLID LOAD CARTRIDGE

• VIEWING RUNS

• MANUAL CONTROL OF THE COMBIFLASH TORRENT MODULE

• SETTING THE VAPOR LIMIT

5.4.1  Editing a method
Editing a method allows you to tailor the operation of the CombiFlash Torrent module to best 
separate or purify the compounds of interest.

PeakTrak has two types of method settings — basic and advanced.
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5.4.1.1  Basic method settings
The basic settings allow you to control the %B gradient mix, flow rate, solvents, and run 
length. These settings are part of the MAIN WINDOW. These settings are the most frequently 
changed settings when developing or improving purification methods.

The %B gradient mix and run length are shown on the plot area. Refer to the DEFINING A 
GRADIENT topic for more details. The other settings are:

• Flow Rate — When using the ISCO default column methods, the flow rate is 
automatically set to the optimum flow rate of the column. If using a non-Isco column, 
refer to the manufacturer’s column documentation to determine the best flow rate for the 
column. Note that if the column is not detected by the module, the operating pressure is 
limited to 50 psi.

• Solvent A and B — Select the desired solvents from the lists. The solvents are those 
defined by the CONFIGURATION window.

5.4.1.2  Advanced method settings
The METHOD EDITOR window gives you access to advanced settings such as equilibration 
volume, initial waste, air purge, peak detection, and peak collection mode.

Equilibration Volume Column equilibration is optional, but you may find that separations are 
more effective if the column is equilibrated before injecting the sample. The recommended 
equilibration volume is at least three column volumes of the starting mobile phase.

Initial Waste & Time Windows The initial waste diverts a user-determined line volume to the waste 
port until the eluant is about to be collected. At the start of a run, the internal solvent lines 
hold some solvent from the previous run. This volume can be diverted to waste, along with 
the anticipated volume of fluid that will pass through the column before a compound of 
interest will elute. 

Time Windows can limit the fraction collection to specific time durations of the run. To use 
time windows enter a start time and an end time. All times are relative to start of the run, 
just following the sample injection. Then choose a peak collection mode. If you select Peaks 
the module will collect fluid only when the time window is active and a peak is present. If you 
select All the module will collect all fluid during the time window regardless of the peak state. 
Define up to six time windows.

• Time windows and fraction overlays when using Solvent Select Valve for Multiple 
Injections with Funnel Rack or Fractionation Valve When Time Windows are set, if 
Peak detection is enabled, it will trigger collection with the peak, but won’t trigger 
transition to a new fraction or tube until the specific time window ends (this prevents a 
false peak from triggering a fraction change leading to contamination). If there is no 
peak detected in a time window it will switch to the next tube once the new time window 
begins to avoid cross contamination of fractions.

If wanting to use time windows with no detection triggering fraction collection, be sure 
that time windows is set to ALL and to turn the detector to monitor only.

Air Purge You can program the module to purge the column with air after a run. This feature 
allows you to remove solvents from the column before it is discarded. Enter the desired time 
to purge the column, in minutes. To disable the post-run air purge, enter zero minutes.
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Peak Collection There are three peak collection options: All, Peaks, or None. The All option will 
collect peak and non-peak fluid in tubes. The Peaks option will collect only peak fluid in tubes 
and divert all other fluids to the waste port. The None option will divert all fluids, peak and 
non-peak, to the waste port. The None option is useful for developing custom methods that 
perform a column wash, system cleaning, or similar function where solvents and elute do not 
need to be collected.

When using the All or Peaks options, you can specify the maximum Peak and Non-peak 
volumes to be collected in the tubes. Be sure to enter volumes less than the maximum tube 
capacity. Different peak and non-peak tube volumes can be used to conserve tubes when using 
the All peak collection mode by collecting large volumes of non-peak fluid while creating more, 
smaller fraction volumes of fluids of interest.

The Foxy fraction collector or Fractionation Valve will advance to the next tube whenever a 
peak is detected. Also note that the fraction collector or valve will advance to the next tube if a 
new peak is detected before completing the last one (sometimes called a double advance). Keep 
in mind that the slope and threshold detection methods use algorithms optimize the peak 
detection. For example, peak detection includes a hysteresis to reduce the likelihood of multiple 
tube advances that may occur if there is noise at the beginning or tail end of a peak.

These actions may be overridden if Time Windows are active. See the discussion on INITIAL 
WASTE & TIME WINDOWS. 

Peak Detection This section of the window contains option buttons to enable and disable various 
peak detection options. When an option is enabled, the window also allows you to modify the 
setting details for that peak detection option. All enabled options will be displayed on the 
chromatogram.

 N ot Note

You can select up to two peak detection options (excluding the External option). If using two 
options, such as 1 with 2, PeakTrak considers a peak to be present when either option is true (a 
logical OR).

• 1 and 2 (wavelength 1 and 2) — Enable these options to use and configure primary 
and secondary wavelength detection. When enabled, type or select the peak detection 
wavelength in nanometers, then click the Details button to configure additional settings 
described below.

• Slope Based — Select this option to enable Slope-based peak detection. When enabled, 
peaks will be recorded if the slope algorithm indicates a peak within the Peak Width 
setting.

• Peak Width — Select the average peak width setting. Peak widths are measured at the 
baseline. The slope detector will detect peak widths ranging from about 0.2 to 2 times 
the peak width setting. For example, if you entered a peak width of 1 minute, the range 
would be 12 seconds to 2 minutes. For best operation, the peak width should be set to 
just over the average peak width being separated. For instance, if the average peak 
width is 45 seconds, you should enter a peak width of 1 minute. For most flash 
chromatography, 1 minute is a good starting point for a peak width.

• Threshold Detection — Select this option to enable Threshold peak detection. When 
enabled, peaks will be recorded if the Absorbance Units (AU) value is exceeded.
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• Threshold — Type or select the Absorbance Units value to be used for Threshold 
detection.

• Note: If both Slope and Threshold peak detection methods are checked, PeakTrak 
considers a peak to be present when any one condition is met. This logical OR 
operator means that PeakTrak will cut a peak when either the Slope condition is true, 
or when the Threshold condition is true.

• All Wavelength Detection — Enable this option to detect peaks within a user-selected 
range of wavelengths. When enabled, click the Details button to configure additional 
settings. These settings include the slope-based and peak width options described in 1 
and 2 above. Additionally, you can type or select the minimum and maximum 
wavelengths limits in nanometers.

• External Detector — Enable this option to use a 0 to 1 volt analog input signal from an 
external detector. When enabled, click the Details button to configure additional 
settings. These settings include the slope-based and peak width options described in 1 
and 2 above. PeakTrak will use its internal algorithms to cut detect and cut peaks 
based on the analog input signal. Refer to the External Detector instruction sheet for 
electrical and plumbing requirements.

• Show Ratio — If using two of the above peak detection options, check this option to 
display a ratio of the selected wavelengths. The ratio trace is often a useful indicator of 
purity. Refer to the MONITORING THE WAVELENGTH RATIO topic for more details on this 
feature.

5.4.1.3  Saving Changes to the Method File
After you have edited the method file, you can save the changes for future use. Click the Save 
As button, give the method file a descriptive name, then click the Save button. The method 
file will be stored by the module and will be available for future runs.

5.4.2  Alternative Ways to Create Method Files
Other than editing a method file on the CombiFlash Torrent module, there are more ways to 
create method files.

5.4.2.1  Importing Method Files from Another System 
If a method file is located on a CombiFlash Rf system or another CombiFlash Torrent module, 
you can use the FILE>EXPORT METHOD menu command to save the method file on an external 
storage device. From the touch screen panel, this storage device is a USB Flash Drive 
connected to the USB port below the display. If connected to the module via an Internet 
browser, the storage device may be any device that can be accessed by the local computer. 

To move the method file onto the module, insert the USB flash drive into the USB port or 
connect to the module from the remote computer, then use the FILE>IMPORT METHOD menu 
command to locate and import the method file.

5.4.2.2  Extracting a Method File from a Previous Run
You can perform real-time editing during a run to fine tune the method. After the run, you 
can extract the run parameters as a method file so it can be used on future runs. To do so, 
open the Run file and click the Extract button. The module will load a new method with 
identical run parameters. You can then save the method using the FILE>Save or Save As 
menu commands.
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5.4.2.3  Scaling Method Files to Different Column Sizes
If you want to scale a method file to a different column size, use the FILE>Save As menu 
command. From the FILES window, select the Scale option, then choose the new column size 
and click the Save button. The module will create a new method file with the gradient and run 
parameters scaled to the new column size.

This feature is useful when developing methods using small sample volumes. After you 
optimize the method to successfully extract the compounds of interest, you can then scale up 
the method to load and extract larger volumes using larger RediSep column sizes.

5.4.3  Editing a Default Method
Default Methods allow you to quickly recall standard method settings. There are standard 
methods for each size and type of RediSep column. When shipped from the factory, the Default 
Methods were set to the settings recommended by Teledyne ISCO.

The Default Method settings can be tailored to your application. To modify the Default 
Methods:

1.Select the TOOLS>EDIT DEFAULTS menu command.

2. If prompted for a password, enter the module password. (The SET PASSWORD window 
controls the password protection feature.)

3.Select the column size and media from the RediSep Column list.

4.Change the settings to meet your specific application requirements. Refer to the EDITING A 
METHOD instructions.

5.Click the Save button (or File>Save) to replace the default method settings.

You can reset the method to Teledyne ISCO-recommended defaults. While viewing the default 
method file for a selected column size and type, click the “Reset file to ISCO defaults” button. 
The settings will revert to the original factory settings. Click the Save button to save the 
settings for future use.

5.4.4  Defining a Gradient
The simplest way to change the gradient is to click and drag the inflection points that define 
the shape of the gradient. Add a point by clicking the Insert button, then click the gradient 
curve to add a point. You can then drag the new point to the desired location. Delete a point by 
clicking the Delete button and then clicking the undesired inflection point.

The above methods work in the MAIN WINDOW and METHOD EDITOR window. Alternatively, you 
can modify, add, insert, and delete points using a tabular view on the Method Editor window. 
Click the Edit Gradient button to open this view, then use the controls to modify the settings. 
Click the Edit Gradient button again to close the table view.

PeakTrak can also optimize a gradient from your TLC results. To use this feature, select a 
single solvent system and run two TLC plates, each with a different concentration of solvent. 
For example, run one plate at 1:1 hexane:ethyl acetate, the other at 1:3 hexane:ethyl acetate. If 
the resulting Rf values are between 0.2 and 0.8, you can enter the TLC data in the window. 
When you accept the data, PeakTrak will generate a gradient curve to separate the target 
compound from the nearest impurity. When using optimized gradients, PeakTrak may 
automatically insert an isocratic hold to further increase the resolution.
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5.4.5  Real-time Gradient Editing
The gradient shape can be changed during the run. Any time after the fraction collector has 
positioned the drop former over the first tube, click and drag the points on the gradient plot 
area of the Main window. You can also add or remove points by clicking the Insert or Delete 
point buttons. The Insert button allows you to add a single point when you click on the 
gradient profile. Repeat this action to add more points. The Delete button allows you to 
remove a single point when you click on it.

Note that only the portion of the gradient that has not yet occurred during the run can be 
modified.

5.4.6  Monitoring the Wavelength Ratio
When using two peak detection options, such as 1 with 2 or All Wavelength Detection with 
External, a ratio of the detection sources can also be displayed, which at times can provide 
the best indication of compound purity. Refer to the following discussion.

If a pure compound is eluting, the absorbance is linearly related to the concentration of the 
compound in the solvent. If the compound absorbs differently at different wavelengths, the 
absorbance at each wavelength may be different, but still linearly related. For example, 
assume a compound eluting from the module has an absorbance equal to 2 times the 
concentration at 254 nm. This same compound at 220 nm has an absorbance of 1.5 times the 
concentration. The ratio of these signals will be 1.33. Since the relationship of absorbance to 
concentration is not variable, the ratio remains steady while the concentration changes from 
the beginning to the end of the peak. During the duration of the peak, the ratio will be 1.33 
and this constant value is displayed as a horizontal line.

Now assume a case where there is a second compound eluting, only slightly shifted in time 
from the original compound. It is possible that the detection absorbance trace alone would 
indicate a single, valid chromatographic peak. In reality, it is a combination of two peaks. By 
monitoring a second wavelength, it may be possible to reveal the second compound. Because 
of the slight shift in time and the different absorbance properties of the two compounds, the 
changing ratio during the detected peak would reveal the impurity. Therefore, one can 
therefore assume that if the ratio is not constant for the entire duration of the peak, the 
compound eluting may not be pure.

To display the ratio, open the METHOD EDITOR window and select the Show Ratio option. 

5.4.7  Bypassing the Solid Load Cartridge
Occasionally, impurities precipitate in the solid load cartridge as compounds are purified. 
This may cause high back pressures resulting in reduced flow rates and long run times. 
Clicking this button changes the injection valve position, which removes the solid load 
cartridge from the solvent path and relieves the back pressure.

CAUTION

Bypassing the solid load cartridge too soon during the purification run may leave desired 
compounds on the solid load cartridge. After removing the cartridge from the fluid path, 
these compounds cannot be purified.
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If you need to use this feature, perform the following to ensure that you do not leave desired 
compounds on the cartridge:

1.Run a TLC plate prior to starting the run. Measure the Rf (retention factor) of the slowest 
eluting compound of interest. (The Rf should be between 0.2 and 0.8 — the same range used 
by the Gradient Optimizer. Note the Percent B solvent used to run the TLC plate. If a 
compound displays tailing peaks as streaks on TLC, the Rf used corresponds to the bottom of 
the streak.

2.Load the Sample in the Solid Load Cartridge and note the cartridge size. Refer to list below 
to determine the cartridge volume. If the cartridge is partially filled with silica, use the 
cartridge volume as if the cartridge were completely filled with silica.

• 5 gram cartridge = 10 mL volume

• 25 gram cartridge = 45 mL volume

• 65 gram cartridge = 110 mL volume

3.Run the sample and observe the flow rate from the Status Bar in the upper right corner of 
the main window. As long as the system is delivering the programmed flow rate, there is no 
need to bypass the cartridge.

4. If the flow rate is slower than that programmed, note the slowest displayed flow rate. Use 
the equation below to determine if the cartridge can be bypassed.

T = Cartridge Volume / (Rf * Flow Rate) 

Where T is the time in minutes to wait after the system reaches the %B solvent used to run the 
TLC plate; Rf is the retention factor measured in step 1; Cartridge Volume is the volume in mL 
from step 2; and Flow Rate is the current flow rate in mL/min.

5.Observe the current %B concentration in the status bar. Once the system reaches the %B 
percentage used for the TLC, wait at least the time established as T. After this time has 
elapsed it is likely that the desired compound has come off the cartridge and you can safely 
click the Cartridge Bypass button.

For example, a TLC plate run at 30%B revealed that the last desired compound had an Rf 
factor of 0.35. An empty 25-gram size solid load cartridge was filled with sample adsorbed onto 
10 grams of silica, and then placed on the system. The programmed flow rate was 60 mL/min. 
During the run, the flow rate dropped to 30 mL/min. The equation is then:

T = 45 mL / (0.35 * 30 mL/min) = 4.3 minutes

In this example, the Cartridge Bypass feature was used 4.3 minutes after the solvent gradient 
reached 30% B.

The calculation is conservative, but allows you to minimize the time needed to keep the solid 
load cartridge in the fluid path.

5.4.8  Viewing runs
After completing a run, the PeakTrak Main window is used to display all collected run data. 
You can also open previous runs to view the chromatogram and the peak/tube locations. To 
open a previous run:

1.From the main window, select File>Open, or click the Open button. The FILES window is 
displayed.
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2.Choose a Run file and click the Open button.

3.PeakTrak displays the run in the MAIN WINDOW.

The PeakTrak Main window will include:

• Rack and tube information — The left pane of the window lists the current rack, a 
map for that rack, and a table that lists the peaks and their corresponding tube 
numbers. If the window is currently displaying the collection parameters, click the Rack 
View button to view this information.

• Method parameters — Click the Display Method button to view a summary of the 
peak detection and collection settings for the run.

• Chromatogram — The right side of the window displays the chromatogram, identified 
by the Sample Name in the title bar of the window.

• Option buttons — The option buttons give you quick access to frequently used 
commands while viewing a run. The buttons are:

• Print — Click this button to print a run summary. When viewing the run from a 
remote personal computer, the summary can be printed on any installed printer. If 
you are attempting to print from the module’s touch panel display, you must first set 
up NETWORK PRINTING in the NETWORK CONFIGURATION settings.

• Save As PDF — Click this button to save the run summary in PDF file format. When 
viewing the run from a remote personal computer, the summary can be saved to any 
connected storage device. If you are attempting to save a PDF file from the touch 
panel display, insert a USB Flash drive in the USB port below the display panel.

• Save As TXT — Click this button to save the run summary in an ASCII text file 
format. When viewing the run from a remote personal computer, the summary can be 
saved to any connected storage device. If you are attempting to save a TXT file from 
the touch panel display, insert a USB Flash drive in the USB port below the display 
panel.

• Zoom In — Click this button to enable the zoom feature. Then, click and drag across 
the region to be magnified.

• Zoom Out — Click this button to restore the chromatogram to the normal view.

• Format Graph — Click this button to open a window from which you can set the X 
and Y-axis scales. 

• Extract Method button — Click the Extract button to load a new method file based on 
the parameters for the run you are viewing.

• Close button — Click the Close button when you are done viewing the run.

5.4.8.1  General instructions for reading the data
Most elements on the window are color-keyed to help you locate the tubes containing the 
peaks of interest. Below each collected peak there is a color bar that matches a tube in the 
map on the left. The tube map provides a visual representation of the tubes that contain the 
peaks of interest. If you wish to identify the tube by number, refer to the table below the rack 
diagram.

If the run used multiple Foxy fraction collector racks, or multiple Fractionation Valve bottle 
sets (also considered racks), the Previous and Next Rack buttons are active. Click these 
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buttons to scroll through the available racks. The number of the currently displayed rack is 
shown at the top left of the window.

5.4.8.2  Reading the Chromatogram
The plot area displays the following:

• The red absorbance trace produced by the module’s peak detector. Absorbance units (also 
shown in red) that correspond to this trace are shown on the left Y-axis.

• Purple absorbance and green ratio traces may be visible if you are monitoring a second 
wavelength. See the MONITORING THE WAVELENGTH RATIO help topic.

• The gradient curve that was used during the run. The % Solvent B scale is shown in blue 
on the right Y-axis.

• The X-axis depicts the run time, shown as minutes or COLUMN DATA.

• Vertical lines may appear at intervals along the X-axis. These lines indicate collection tube 
changes. To prevent the plot area from being obscured by tube change marks, PeakTrak 
may limit the number of marks.

5.4.9  Manual Control of the CombiFlash Torrent Module
Manual Control can assist with method development, maintenance of the module plumbing, 
and system troubleshooting. To manually control the CombiFlash Torrent module, first open 
the MANUAL CONTROL window by selecting the Tools>Manual Control menu command.

Figure 5-3  Manual Control

5.4.9.1  Pumping Solvents
To pump either solvent, select the solvent from the Solvent A or Solvent B lists. Then, click the 
Prime A or Prime B buttons to pump the selected solvent. To pump a mixture or Solvent A and 
B, adjust the Percentage Solvent B setting and then click the Prime __% B button. When 
finished, click the Stop button.

You can control the flow rate by adjusting the Flow Rate mL/min setting. 

By default, the module pumps the solvent directly to the waste port. You can change the fluid 
path by selecting a different Valve Position option (through column or through cartridge and 
column). For valve positions other than Direct To Waste, you can pump the solvent into a 
collection tube. To do so, select the Pump Into Tube # option and then select which tube (“next” 
or specific tube number). 
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5.4.9.2  Air Purging
You can purge the solid sample cartridge and column path with air. To air purge a path, click 
the Air Purge Solid Sample or Air Purge Column buttons. Click the Stop button to halt the air 
purge. 

5.4.9.3  Raw Lamp Energy
The right side of the Manual Control window shows a Raw Lamp Energy gauge. This 
provides an indication of the UV light measured by the optical detector at 254 nm. High lamp 
energy (green) means that the flow cell easily passes through a sufficient UV light source. 
Lower lamp energy (yellow or red) means that either the light source is weak or that the flow 
cell is obstructed.

• Green – lamp energy is sufficient to detect peaks up to 3.0 Absorbance Units.

• Yellow – lamp energy is partially obstructed and the peak detector performance might 
be impaired. The module can be operated although the absorbance trace might appear 
noisy. Yellow might be a normal indication for modules with flow cell windows stained by 
compounds.

• Red – lamp energy is obstructed to a degree that the module might not reliably detect 
peaks. If you attempt to operate the module, peak collection will be forced to collect all. 
This prevents diverting desired compounds to waste.

Depending on what you are doing with the Manual Control functions, low lamp energy could 
be a normal indication. For example, a UV-absorbing compound could be present in the flow 
cell as you are pumping solvent. Or, the selected solvent absorbs UV light at 254 nm. 
Abnormal indications could be a flow cell blocked by a compound that has precipitated or 
there is a film built up on the flow cell. If you suspect the low lamp energy is an abnormal 
indication, perform the steps in the QUICK CLEANING WHEN RECOMMENDED topic.

5.4.10  Setting the Vapor Limit
The module has an internal vapor sensor that detects vapors present in the module. When 
the limit is exceeded, the CombiFlash Torrent module will shut down to avoid a hazardous 
condition.

Teledyne ISCO recommends using the default setting of 12. This value represents an organic 
vapor level slightly above the ambient vapor level of a well-ventilated laboratory.

A setting below 12 could cause random alarms without significant vapors present. If 
PeakTrak displays a Vapor Limit alarm while the Vapor Limit is set at 12, perform the 
following checks on your laboratory and the instrument:

• Ensure that no open containers or spills of organic solvent are in close proximity to the 
module.

• Ensure that the module is located in a well-ventilated area.

• Ensure that there is no visible solvent leakage from the module.

If PeakTrak continues to display the Vapor Limit alarm after you have made these checks 
and corrected any problems found, it is likely that organic vapors are present in the ambient 
environment of your laboratory. In this case, increase the setting of the Vapor Limit. Settings 
greater than 12 are appropriate for laboratory environments with a somewhat elevated 
background solvent vapor concentration, representing a safe setting, but one with a reduced 
margin for error.
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CombiFlash Torrent®

User Manual

Section 6 Maintenance

6.1  System Standby and Shut Down 
During extended periods of inactivity, you can place the system in Standby to conserve power. 
To do so, log off the system (File> Log out) and place the On/Standby switch in Standby .

When in the Standby state, normal system operation is no longer available from the touch 
screen or remotely. However, some internal components are still powered. 

WARNING

As long as the AC mains power cord is connected, power is inside the unit. The mains power 
cord is the disconnect device. Position the CombiFlash Torrent module so that the power 
cord can be unplugged, or use a power strip where the plug can quickly be removed from 
the outlet in the event of an emergency.

When you first place the system in Standby, internal components continue to operate for 
almost one minute while performing file maintenance and preparing the system for possible 
power removal.

CAUTION

Removing the AC mains power cord before the file maintenance is complete might corrupt 
files on the internal hard drive. These corrupted files can cause abnormal operation or a 
complete system failure that requires service. Unless power must be removed due to an 
emergency, always wait at least one minute after placing the system in Standby before 
removing the AC mains power cord.

6.2  Preventive Maintenance
The system requires preventive maintenance by the user for safe and reliable operation. 
Refer to the schedule below for the minimum periodic maintenance requirements.

As Needed – Perform these tasks as conditions require:

• Cleaning (section 6.3).

• Quick flow cell cleaning when recommended by a system alert message (section 6.5.2).

Every Run – Allow the separation run to finish with a high percentage of solvent B to flush 
residual compounds from the column, internal tubing, and flow cell. Refer to section 6.5.1.

Monthly – Perform these tasks at least monthly, more frequently if conditions warrant:

• Tubing Inspection (section 6.4).

• Collection rack and tray cleaning (section 6.3.1).

• Monthly flow cell cleaning (section 6.5.3).
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Additional periodic maintenance tasks should be performed at one and five year intervals by a 
qualified technician. These tasks include:

Yearly – Perform the tasks identified in Teledyne ISCO instruction sheet 60-5243-184.

Every Five Years – Replace internal battery.

Contact Teledyne ISCO’s Technical Service Department for more information regarding 
periodic maintenance.

6.3  Cleaning
To clean the exterior surfaces, use a cleaning cloth dampened with a mixture of distilled water 
and a mild detergent. Use isopropyl alcohol for tougher stains. 

On printed areas such as labels, avoid rubbing vigorously or using aggressive solvents like 
acetone. Each will ruin the printed text.

CAUTION

Do not immerse the instrument in a water bath or subject it to a liquid spray. The instrument 
is not watertight and these actions could damage the internal electronics.

6.3.1  Collection Rack and Tray Cleaning

WARNING

Risk of fire or equipment damage. Unclean collection racks and tray might inhibit their 
conductive properties. The racks and tray must be kept clean to dissipate static electricity.

If using Foxy R2 High Flow fraction collectors, the collection tube racks and tray are made of 
conductive plastic. Dirt, film, or coatings might prevent their ability to dissipate static 
electricity. To avoid problems that possibly result from an electrostatic discharge, clean the 
racks and tray monthly. Use distilled water with a mild detergent. For tougher stains, use 
isopropyl alcohol.

If using the Fractionation Valve option, clean the tubing, collection vessels, and related 
equipment as necessary. Ensure that system grounding complies with local directives.

6.4  Tubing Inspection

WARNING

Risk of fire or equipment damage. Faulty tubing, fittings, and drains may allow organic 
solvents to pool in unsafe areas, creating a potential for dangerous levels of flammable 
vapors. Improper draining may damage the instrument’s internal components.

Perform a tubing inspection monthly:

1.Visually inspect the solvent, waste, and drain tubing. The tubing must be free of any 
damage, kinks, or deterioration. Fittings should show no signs of leaks.

2.Test the drip tray drain by connecting a vacuum or air supply source to the outlet end of the 
drain tube. Then, verify the presence of such vacuum or air supply source on the drain hole 
on the drip tray.

Correct any deficiencies before returning the instrument to operation.
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6.5  Flow Cell Cleaning

6.5.1  Post Separation
As a preventive measure, all default column methods finish the separation run with a high 
percentage of solvent B (Figure 6-1). This brief time (two to three column volumes) of strong 
solvent flushes residual compounds from the column, flow cell, and internal tubing.

Skipping the post-separation flush may cause residual compounds to build up and crystallize, 
which might result in:

• cross contaminating later separation runs

• higher operating pressures

• reduced flow cell lamp energy

• a noisy baseline on the absorbance trace

• frequent messages recommending flow cell cleaning (Figure 6-2).

Figure 6-1  Default post-separation column and flow cell flush

Figure 6-2  Flow cell cleaning message

Typically, chemists Stop and then Fast Forward the run after the last compound elutes. This 
action skips the post-separation flush. If any of the above conditions appear, consider 
allowing some of the runs to continue through the flush, or run a high percentage of %B 
solvent through the system for a few minutes at the end of each day. 

If the separation runs always continue through the flush and the conditions still occur 
frequently, edit the default column methods to extend the flush duration. 
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CAUTION

When using methanol as solvent B with silica column media, do not pump more than 50% 
solvent B. Higher percentages of methanol might break down the silica structure, possibly 
causing obstructions in the flow path.

6.5.2  Quick Cleaning when Recommended
When the lamp energy is lower than normal, the system will recommend flow cell cleaning 
(Figure 6-2) before starting a separation run.

When the system displays this message you can:

• Cancel Run (recommended) – Click the Cancel Run button so you can perform a quick 
cleaning described in the following steps.

• Continue Collect All – Click this button to ignore the message. Because the peak 
detection operation might be impaired, the system automatically collects all fluids to avoid 
diverting compounds of interest to waste.

• Help – Click this button to display the flow cell cleaning on-line help topic.

To perform a quick cleaning:

1.After clicking the Cancel Run button, select the Tools>Manual Control menu option.

2.From the Manual Control window (Figure 6-3), note the Raw Lamp Energy level at 254 nm. 
The Raw Lamp Energy gauge has three ranges: red, yellow, and green.

Figure 6-3  Raw Lamp Energy Gauge

• Red – lamp energy is obstructed to a degree that the system might not reliably detect 
peaks. If you attempt to operate the system, peak collection will be forced to collect all. 
This prevents diverting desired compounds to waste.

• Yellow – lamp energy is partially obstructed and the peak detector performance might 
be impaired. The system can be operated although the absorbance trace might appear 
noisy. Yellow might be a normal indication for systems with flow cell windows stained 
by compounds.

• Green – lamp energy is sufficient to detect peaks up to 2.4 Absorbance Units.

3.Remove the column and insert a bypass tube (P/N 209-0165-76) between the upper and 
lower column mounts. 

4.Set the Flow Rate to 200 mL/min (Figure 6-4).

5.Select Through column for the Valve Position option.
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6.Select Next for the Pump into Tube # option. By pumping into a collection tube, the 
diverter valve is also cleaned of any residue during this operation.

7.Click the Prime B button to pump 100% Solvent B through the bypass tube and into the 
collection tubes.

Figure 6-4  Manual Control Settings - Quick Cleaning

 N ot Note

Pumping solvent B at a moderate flow rate (150 to 200 mL/min) over time will usually solubilize 
obstructions. Generally, the recommended solvent is the highest polarity solvent you have 
recently used (solvent B).

8.Monitor the Raw Lamp Energy gauge. As the system pumps solvent, the raw lamp energy 
should gradually improve. Pump solvent for two to five minutes or until the indicator 
reaches the far-right of the green range.

When the indicator is in the yellow, the lamp energy and flow cell are ready for the next run. 
However, continuing the cleaning for greater raw lamp energy should reduce the frequency of 
flow cell cleaning messages (Figure 6-2).

If after five minutes the indicator is still in the red range, repeat the cleaning steps using an 
alternative solvent (Table 6-1). Or, complete the steps in the Monthly Flow Cell Cleaning 
procedure (section 6.5.3).

 N ot Note

If the numerical values of the Raw Lamp Energy (Figure 6-3) do not change, or if the first number 
remains at zero, contact Teledyne ISCO’s Technical Service department.
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6.5.3  Monthly Flow Cell Cleaning
Perform this procedure as part of your scheduled preventive maintenance, or when Quick 
Cleaning As Required (section 6.5.2) does not improve the lamp energy.

1.Remove the column and insert a bypass tube between the upper and lower column mounts. 
A bypass tube (209-0165-46) can be found in the accessory kit (60-5239-006).

2.From the menu, select Tools>Manual Control. This opens the Manual Control window.

3.Set the Flow Rate to 200 mL/min (Figure 6-4).

4.Select Through column for the Valve Position option.

5.Select Next for the Pump into Tube # option.

6.Place the B1 Solvent inlet line into a reservoir of methanol, acetone, or a strong solvent that 
readily dissolves residual sample material. 

7.Click the Prime B button to pump 100% Solvent B through the bypass tube and into the 
collection tubes. 

8.After three minutes, click the Stop button. Allow the system to stand for at least six hours. 
Overnight is recommended.

9.Return the B1 solvent line to the original solvent container. 

Table 6-1 Suggested Flow Cell Cleaning Solventsa

a. Recent synthesis solvents should also be considered.

Solvent Description

Methanol Miscible with most LC solvents. Methanol will force other solvents through 
the system so they will not interfere with the next sample. It breaks down 
the tertiary structure of silica and allows it to flush through.

Acetone Common organic solvent with high dissolving properties. Acetone 
absorbs UV light at 254 nm. Therefore, the Raw Lamp Energy gauge will 
always read red when acetone is in the flow cell. After pumping acetone, 
pump a different solvent through the system to remove the acetone and 
read the Raw Lamp Energy gauge.

Dichloromethane (DCM) Effective at solubilizing organic molecules.

Dimethylsulfoxide (DMSO) Strong solvent that will clear organic sample.

Dimethylformamide (DMF) Strong solvent if other solvents do not produce the desired results.

Tetrahydrofuran (THF) Strong solvent.

Water/DMF/
methanol

A 50/25/25 solvent mixture effective in clearing some obstructions.

Water/DMF/
Acetic Acid

30/30/30ml solvent mixture effective in clearing some obstructions.

Mildly acidic aqueous 
solution

0.5M acetic acid in distilled water can be used to clear samples that are 
not removed by organic solvents.

Mildly basic aqueous 
solution

A dish-type detergent solution can wash through particulates not picked 
up by the acidic solution. The emulsification effect of detergent is an 
effective tool as well to help wash through oily samples. Follow the 
detergent with several minutes of clean, distilled water.
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10.Perform the Quick Cleaning as Required (section 6.5.2) and monitor the Raw Lamp 
Energy.

If the lamp energy is in the green or yellow range, return the system to operation. If the 
lamp energy is red, contact Teledyne ISCO’s Technical Service department for assistance.

6.6  Electrical Troubleshooting
If your instrument stops working and the touch panel display is off, check the line cord 
connection.

If the line cord is connected properly, check the fuses in the power input module located on 
the system’s rear panel. These are time delay fuses (T-type) and rated according to the mains 
input power voltage:

• 100 to 129 VAC mains input: 3.0 A fuse.

• 215 to 264 VAC mains input: 1.5 A fuse.

CAUTION

Always replace fuses with the same type and rating. 
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